LyX’s detailed Math manual

by the LyX Team*

Version 2.2.x

April 16, 2017

*If you have comments or error corrections, please send them to the LyX Documentation mailing list: lyx-docs@lists.lyx.org
## Contents

1. **Introduction**  

2. **General Instructions**  

3. **Basic Functions**  
   3.1. Exponents and Indices  
   3.2. Fractions  
   3.3. Roots  
   3.4. Binomial Coefficients  
   3.5. Case Differentiations  
   3.6. Negations  
   3.7. Placeholders  
   3.8. Lines  
   3.9. Ellipses  

4. **Matrices**  

5. **Brackets and Delimiters**  
   5.1. Vertical Brackets and Delimiters  
      5.1.1. Manual Bracket Size  
      5.1.2. Automatic Bracket Size  
   5.2. Horizontal Brackets  

6. **Arrows**  
   6.1. Horizontal Arrows  
   6.2. Vertical and diagonal Arrows  

7. **Accents**  
   7.1. Accents for one Character\(^1\)  
   7.2. Accents for several Characters  

8. **Space**  
   8.1. Predefined Space  
   8.2. Variable Space\(^2\)  
   8.3. Space besides inline Formulas  

9. **Boxes and Frames**  
   9.1. Boxes with Frame  
   9.2. Boxes without Frame  
   9.3. Colored Boxes  

---

\(^1\) accents in text see sec. 16.2  
\(^2\) for vertical space in formulas see sec. 18.1.1
9.4. Paragraph Boxes ......................................................... 25

10. Operators ................................................................. 27
    10.1. Big Operators ....................................................... 27
    10.2. Operator Limits .................................................... 28
    10.3. Decoration for Operators ........................................ 30
    10.4. Binary Operators .................................................. 31
    10.5. Self-defined Operators ........................................... 31

11. Fonts ......................................................................... 32
    11.1. Font Styles .............................................................. 32
    11.2. Bold Formulas ........................................................ 33
    11.3. Colored Formulas .................................................... 34
    11.4. Font Sizes .............................................................. 34

12. Greek Letters .............................................................. 35
    12.1. Small Letters .......................................................... 36
    12.2. Big Letters ............................................................ 36
    12.3. Bold Letters ........................................................... 36

13. Symbols³ ...................................................................... 37
    13.1. Mathematical Symbols ................................................ 37
    13.2. Miscellaneous Symbols ............................................. 37
    13.3. The Euro-Symbol € .................................................. 38

14. Relations ...................................................................... 38

15. Functions ..................................................................... 39
    15.1. Predefined Functions ................................................ 39
    15.2. Self-defined Functions .............................................. 40
    15.3. Limits ................................................................. 40
    15.4. Modulo-Functions ................................................... 41

16. Special Characters ....................................................... 41
    16.1. Special Characters in Mathematical Text ....................... 42
    16.2. Accents in Text ....................................................... 42
    16.3. Old-style Figures ..................................................... 43

17. Formula Styles ................................................................ 43

18. Multiline Formulas ....................................................... 44
    18.1. General ................................................................. 44
        18.1.1. Line Separation .................................................. 44

³A list with all symbols of most of the \LaTeX-packages can be found in [4].
18.1.2. Column Separation ................................................. 45
18.1.3. Long Formulas .................................................. 46
18.1.4. Multiline Fractions ............................................... 47
18.1.5. Multiline Brackets ............................................... 47
18.2. Align Environments .................................................. 48
18.2.1. Standard align Environment ................................. 48
18.2.2. Alignat Environment .......................................... 48
18.2.3. Flalign Environment ........................................... 49
18.3. Eqnarray Environment .............................................. 49
18.4. Gather Environment ................................................ 49
18.5. Multline Environment ............................................. 49
18.6. Multiline Formula Parts .......................................... 50
18.7. Text in multiline Formulas ....................................... 51

19. Formula Numbering ................................................... 52
19.1. General .............................................................. 52
19.2. Cross-References .................................................... 52
19.3. Subnumbering ....................................................... 53
19.4. User-defined Numbering ......................................... 54
19.5. Numbering with Roman Numbers and Letters ............. 56

20. Chemical Symbols and Equations .................................. 57

21. Diagrams .................................................................. 58
21.1. Amscd Diagrams .................................................... 58
21.2. Xymatrix Diagrams ................................................. 59
21.3. Feynman Diagrams .................................................. 59

22. User-defined Commands .............................................. 60
22.1. The Command \newcommand .................................... 60
22.2. Math Macros ......................................................... 61

23. Computer Algebra Systems ......................................... 63
23.1. Usage ................................................................. 63
23.2. Keyboard shortcut .................................................. 64

24. Miscellaneous .......................................................... 64
24.1. Negative Numbers ................................................. 64
24.2. Comma as decimal Separator .................................... 65
24.3. Physical Vectors ..................................................... 65
24.4. Self-defined Fractions ............................................. 65
24.5. Canceled Formulas .................................................. 67
24.6. Formulas in Section Headings ................................... 67
24.6.1. Heading without formula in table of contents .......... 68
24.6.2. Heading with formula in table of contents $\sqrt{-1} = i$ . 68
1. Introduction

This document explains \LaTeX’s math features and is furthermore a collection of \TeX-commands used for mathematical characters and constructs. The explanations are designed for the usage of commands. It is therefore required that you have read the section Mathematical Formulas of the User’s Guide.

Most of the characters and many constructs explained in this manual are also accessible via the menu Insert $\math$ or the math toolbar. But everybody who has to write lots of formulas will notice that it is much faster to use commands instead of the math toolbar. Therefore this manual is focused on commands but also mentions the corresponding toolbar buttons when available.

If not specially mentioned the commands are only available within formulas. To be able to use all commands explained in this document, the option Use AMS math package must be checked in the document settings (menu Document $\math$ Settings $\math$ Math Options).\footnote{The option Use AMS math package automatically only uses \AMS-math when math constructs are found that are supported by \LaTeX.}

This document doesn’t list all \AMS-math commands\footnote{A list with all \AMS-math commands is in the file amsguide.ps, which is part of every \TeX standard installation.} for lucidity reasons.

2. General Instructions

To create an inline formula that is embedded into a text line, use one of the shortcuts Ctrl+M, Alt+C M, Alt+M M or the toolbar button $\Sigma$.

To create a display style formula which will appear bigger, has a different format, and will be in a separate paragraph, use one of these shortcuts: Ctrl+Shift+M, Alt+M D.

To change a display style formula to an inline formula, set the cursor into the formula and use one of the shortcuts Ctrl+M, Alt+C M, Alt+M M or the menu Edit $\math$ Change formula type. The same way is used to change an inline formula to a display style formula.

To display parts of an inline formula in the size of a display style formula, enter the command $\displaystyle$ to a formula. Then a new blue box appears in which the desired formula part is inserted.

Only inline formulas are allowed inside tables.

The math toolbar can be turned on in the menu View $\math$ Toolbars. When you click there on “Math” the toolbar will be shown permanently at the bottom; this state is visualized in the Toolbars menu with a checkmark. When you click in this state again on “Math” in the Toolbars menu, the math toolbar is only shown when the cursor is
within a formula; this state is visualized by the renaming of the menu entry from “Math” to “Math (auto)”.

The \TeX mode is invoked by pressing the toolbar button \TeX or by using the menu Insert Æ \TeX Code (shortcut Ctrl+L).

To change the \TeX-preamble, use the menu Document Æ Settings Æ LaTeX Preamble.

To edit matrices, case differentiations and multiline formulas subsequently, use the menus Edit Æ Math and Edit Æ Rows & Columns, or the table toolbar. When lines and columns are swapped via the menu, the column or line where the cursor is in is exchanged with the column to the right or the line below, respectively. Is the cursor in the last column or row, the exchange is done with the column to the left or the line above.

To write text in formulas mathematical text is used. This mode is invoked with the shortcut Alt+C Space or by the insertion of the command \text. The text appears black in \LYX and can therefore be distinguished from the other formula parts which appear blue. In the output mathematical text is set upright, in contrary to other formula parts.

**Command Scheme**

Most of the \TeX-commands for math constructs have the following scheme:

\texttt{\commandname[optional argument]{required argument}}

A command always starts with a backslash \texttt{"\"}. To omit optional arguments, also omit the associated brackets. The braces around the required arguments are named in this document as \TeX braces. If you add in a formula a left brace to a command name, \LYX automatically creates a \TeX brace. In all other cases \TeX braces are created in formulas with the command \texttt{\{}. \TeX braces appear red in \LYX, in contrary to normal braces which appear blue. In \TeX mode no command is needed to get \TeX braces. \TeX braces don’t appear in the output.

When commands without arguments, like commands for symbols are entered in \TeX mode, a space character must always be behind the command to end it. This space doesn’t appear in the output. When the space should appear in the output, the space must be followed by a protected space in normal text.

A protected space is inserted with \texttt{\indéfini}.

\footnote{For multiline formulas the command \texttt{\intertext} is used, see sec. 18.7.}
Syntax Explanation

- The symbol \( \textbackslash \) denotes a space character to be input.
- An arrow like \( \rightarrow \) denotes the usage of the corresponding arrow key on the keyboard. The Tab key can often be used instead of \( \rightarrow \) and \( \downarrow \), and Shift+Tab instead of \( \leftarrow \) and \( \uparrow \).

Available units

<table>
<thead>
<tr>
<th>Unit</th>
<th>Name / Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm</td>
<td>Millimeter</td>
</tr>
<tr>
<td>cm</td>
<td>Centimeter</td>
</tr>
<tr>
<td>in</td>
<td>Inch (1 in = 2.54 cm)</td>
</tr>
<tr>
<td>pt</td>
<td>Point (72.27 pt = 1 in)</td>
</tr>
<tr>
<td>pc</td>
<td>Pica (1 pc = 12 pt)</td>
</tr>
<tr>
<td>sp</td>
<td>scaled point (65536 sp = 1 pt)</td>
</tr>
<tr>
<td>bp</td>
<td>big point (72 bp = 1 in)</td>
</tr>
<tr>
<td>dd</td>
<td>Didot (1 dd ≈ 0.376 mm)</td>
</tr>
<tr>
<td>cc</td>
<td>Cicero (1 cc = 12 dd)</td>
</tr>
<tr>
<td>ex</td>
<td>Height of letter “x” in the current font</td>
</tr>
<tr>
<td>em</td>
<td>width of letter “M” in the current font</td>
</tr>
<tr>
<td>mu</td>
<td>math unit (1 mu = ( \frac{1}{18} ) em)</td>
</tr>
</tbody>
</table>
3. Basic Functions

3.1. Exponents and Indices

Indices are created with an underscore ‘_’ or via the math toolbar button \textsubscript, exponents with a caret ‘\textsuperscript’ or via the math toolbar button \textsuperscript.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>B\textsubscript{V}</td>
<td>B_V</td>
</tr>
<tr>
<td>B\textsuperscript{V}</td>
<td>B^V</td>
</tr>
<tr>
<td>B\textsuperscript{A}</td>
<td>B^A</td>
</tr>
</tbody>
</table>

As the caret is in some languages an accent, vowels will be accentuated in this case and not set as exponents\(^7\). To get exponents in this case, press Space after the caret as in the last example.

3.2. Fractions

Fractions are generated with the command \texttt{\frac} or via the math toolbar button \textsubscript{} \textsuperscript{\textfrac}. The font size is adjusted automatically, depending on whether the fraction is in an inline or display style formula. With the math toolbar button \textsubscript{} \textsuperscript{\textfrac} you can select different fraction types.

With the command \texttt{\dfrac} a fraction can be created that always has the size of a display style formula. With \texttt{\tfrac} the fraction appears always with the size of an inline formula. An example:

A line with the fraction \(\frac{1}{2}\) that was created with the command \texttt{\frac}.

A line with the fraction \(\frac{1}{2}\) that was created with the command \texttt{\dfrac}.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\frac{A}{B}</td>
<td>\frac{A}{B}</td>
</tr>
<tr>
<td>\dfrac{A}{B}</td>
<td>\dfrac{A}{B}</td>
</tr>
<tr>
<td>\tfrac{e^{\frac{1}{2}}}{\frac{1}{3}}</td>
<td>\tfrac{e^{\frac{1}{2}}}{\frac{1}{3}}</td>
</tr>
</tbody>
</table>

\(^7\)Depending on the used keyboard settings this can also happen for characters other than vowels.
For nested fractions the command \texttt{\cfrac} can be used. Here is an example:

\[
\begin{array}{c}
\text{created with } \texttt{\frac} \\
\frac{A}{B + \frac{C + \frac{D}{E}}{F}} \\
\text{created with } \texttt{\cfrac}
\end{array}
\]

The command for the example above is:

\[
\texttt{\cfrac\,A\,B\,+\,\texttt{\cfrac\,C\,+\,\texttt{\cfrac\,E\,F\,D}}}
\]

\texttt{\cfrac} sets the fraction always in the size of a displayed formula, also when it is part of another fraction.

It is possible to specify the alignment of the numerator. The command \texttt{\cfracleft} is used to left align it, the command \texttt{\cfracright} to right-align it. \texttt{\cfrac} centers the numerator. These fractions demonstrate the different alignments:

\[
\begin{array}{c}
\frac{A}{B + C}, \quad \frac{A}{B + C}, \quad \frac{A}{B + C}
\end{array}
\]

Note: \texttt{\cfracleft} and \texttt{\cfracright} are no real \LaTeX{} commands but represent the command \texttt{\cfrac\{alignment\}\{numerator\}\{denominator\}}. Therefore you cannot use them in \LaTeX{} code.

It is often advantageous to combine \texttt{\cfrac} and \texttt{\frac}:

\[
\frac{A}{B + \frac{C + E}{D}}
\]

For inline fractions with a sloped fraction stroke you can use the command \texttt{\nicefrac}: \nicefrac{5/31} or \texttt{\unitfrac}: \unitfrac{5/31} There is furthermore the command \texttt{\unitfracthree} that offers to write a fraction in combination with a number: \unitfracthree{2 \frac{1}{3}}

Note: \texttt{\unitfracthree} is not a real \LaTeX{} command but the command \texttt{\unitfrac\{number\}\{numerator\}\{denominator\}}. Therefore you cannot use it in \LaTeX{} code.

How to define own fractions where the fraction stroke can be changed, is explained in sec. 24.4.

Multiline fractions are explained in sec. 18.1.4.
3.3. Roots

Square roots are created with \( \sqrt{ } \) or the math toolbar button \( \sqrt{ } \), all other roots with the command \texttt{\textbackslash root} or with the math toolbar button \texttt{\textbackslash root}.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\sqrt{A-B}}</td>
<td>( \sqrt{A-B} )</td>
</tr>
<tr>
<td>\texttt{\root_3{A-B}}</td>
<td>( \sqrt[3]{A-B} )</td>
</tr>
</tbody>
</table>

A square root can also be created with \texttt{\textbackslash root} when the root index field is left empty.

With certain indices the distance to the root is too small, like in this formula: \( \sqrt[3]{B} \). The \( \beta \) touches the root. To avoid this, the commands \texttt{\textbackslash leftroot} and \texttt{\textbackslash uproot} are used with the following scheme:

\texttt{\textbackslash leftroot\{distance\}} and \texttt{\textbackslash uproot\{distance\}}

Distance is the number of Big Points (unit bp; 72 bp = 1 inch), that the index should be moved to the left or top, resp.. The commands are written to the index. This way the command

\texttt{\textbackslash root\{\textbackslash leftroot\{-1\}\rightarrow\textbackslash uproot\{2\}\rightarrow\beta\rightarrow B}

produces a correct typeset formula: \( \sqrt[3]{B} \).

3.4. Binomial Coefficients

Binomial coefficients are inserted with the command \texttt{\binom} or with the submenu of the math toolbar button \( \binom{ }{ } \). As with fractions (\texttt{\frac}) in addition to \texttt{\binom} there are the commands \texttt{\dbinom} and \texttt{\tbinom}. For other brackets around binomial coefficients there are the commands \texttt{\brace} and \texttt{\brack}.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\binom_A_B}</td>
<td>( \binom{A}{B} )</td>
</tr>
<tr>
<td>\texttt{\dbinom_A_B}</td>
<td>( \dbinom{A}{B} )</td>
</tr>
<tr>
<td>\texttt{\tbinom_A_B}</td>
<td>( \tbinom{A}{B} )</td>
</tr>
<tr>
<td>\texttt{\brace_A_B}</td>
<td>{\frac{A}{B}}</td>
</tr>
<tr>
<td>\texttt{\brack_A_B}</td>
<td>\left{\frac{A}{B}\right}</td>
</tr>
</tbody>
</table>
3.5. Case Differentiations

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\cases.A→B&gt;0</td>
<td>[ A \quad B &gt; 0 ]</td>
</tr>
</tbody>
</table>
| \cases.Ctrl+Return            | \[ A \quad \text{for } x > 0 \\
|                               | \quad B \quad \text{for } x = 0 |  

After inserting \cases or pressing the math toolbar button \[ \text{Ctrl+Return} \] you can create new lines with the shortcut Ctrl+Return or the table toolbar button \[ \text{Shift+Return} \].

The command \cases is also available via the menu Insert \( \text{Math} \) \( \text{Cases-Environment} \).

3.6. Negations

By inserting \not every character can be displayed canceled. The characters are quasi accentuated by a slash.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\not=</td>
<td>( \neq )</td>
</tr>
<tr>
<td>\not \le</td>
<td>( \nleq )</td>
</tr>
<tr>
<td>\not \parallel</td>
<td>( \nparallel )</td>
</tr>
</tbody>
</table>

The last example shows that not all negations look good. Therefore there are special commands for some negations (see sec. 13.1 and sec. 14).

3.7. Placeholders

When displaying e.g. isotopes the following problem occurs:

Indices created with sub- and superscripts: \( ^{19}F \)

correct indices: \( ^{9}_9F \)

The shorter index is by default placed below or above the first character of the longer index. To avoid this there is the command \phantom or the math toolbar button \[ \text{that creates one or more phantom characters}. When inserting \phantom a small blue box appears that is superposed with two red arrows. The arrows indicate that the complete width and height of the box content will be created as placeholder. Phantom characters are accordingly placeholders with the size of the characters.

\[ \text{Typesetting isotopes and chemical symbols is described in sec. 20.} \]

\[ \text{can be found in the submenu of the toolbar button} \]  

8 Typesetting isotopes and chemical symbols is described in sec. 20.

9 can be found in the submenu of the toolbar button .
Furthermore there are the commands \texttt{\vphantom} (toolbar button \texttt{\phantom}) and \texttt{\hphantom} (toolbar button \texttt{\phantom}). \texttt{\hphantom} creates only space for the maximal height of the characters in the box but not for its width. \texttt{\vphantom} creates only space for the width of the box content. Therefore the boxes of both commands have only one red arrow.

For example the command \texttt{\vphantom\int} creates space for the height of the integral sign, because this is the larger character. An example application is in sec.18.1.5.

Placeholders can also be used for text when they are inserted via the menu Insert \hspace{1em} Formatting \hspace{1em} Phantom:

This is a sentence.

is a sentence.

\section*{3.8. Lines}

\begin{center}
\begin{tabular}{|c|c|}
\hline
Command & Result \\
\hline
\overline A+B & \overline{A+B} \\
\underline A+B & \underline{A+B} \\
\overline,\underline A+B & \overline{A+B} \\
\hline
\end{tabular}
\end{center}

In the last example it doesn’t matter if first \texttt{\overline} or \texttt{\underline} is inserted. To double underline use \texttt{\underline} twice.

It is possible to place up to 6 lines above or below characters.

Custom lines can be created using the command \texttt{\rule} which has the following scheme:

\texttt{\rule[vertical offset]{length}{thickness}}

The optional vertical offset shifts the line upwards (or downwards, when the value is negative). The units listed in Table 1 can be used for the values. Here are two

\footnote{The command \texttt{\int} creates an integral sign, see sec.10.1.}
example lines created with the commands \rule[-2ex]{3cm}{2pt} and \rule{2cm}{1pt}:

This is a sentence \rule[-2ex]{3cm}{2pt} with two lines.

\rule can also be used for text when a line is inserted via the menu Insert $\triangleright$ Formatting $\triangleright$ Horizontal Line:

This is a sentence \rule{2cm}{1pt} with one line.

### 3.9. Ellipses

There are different types of ellipses available.\(^{11}\) For listings dots at the baseline are used (\ldots), while for operations dots are needed that are on the same height as the operators (\cdots). When using the command \ldots, \LaTeX{} decides on the basis of the next character what type is used.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A_1,\ldots,A_n$</td>
<td>$A_1,\ldots,A_n$</td>
</tr>
<tr>
<td>$A_1+\cdots+A_n$</td>
<td>$A_1+\cdots+A_n$</td>
</tr>
<tr>
<td>\vdots</td>
<td>\vdots</td>
</tr>
<tr>
<td>\ddots</td>
<td>\ddots</td>
</tr>
<tr>
<td>\iddots</td>
<td>\iddots</td>
</tr>
</tbody>
</table>

$3\times3$ matrix with the different dots

\[ A_{11} \cdots A_{1m} \]
\[ \vdots \cdots \vdots \]
\[ A_{n1} \cdots A_{nm} \]

The ellipses available in menu Insert $\triangleright$ Special Character are \ldots.

To use \iddots, one of the options Use mathdots package (automatically) must be set in the document settings under Math Options.

Using the option Use mathdots package will improve the appearance of all dots in the documents if their font style or size is not the default.

Specially for matrices there are ellipses that span over several columns. They are created with the command \hdotsfor, that has the following scheme:

\(^{11}\)In the math toolbar in the submenu of the button …
\hdotsfor[distance]{number of columns}

The number of columns specifies how many columns should be spanned. Distance is a factor for the distance between the dots.

In the following matrix the command \hdotsfor[2]{4} was inserted in the first box of the second line, to get an ellipsis with a dot distance twice as long as with the command \dots:

\[
\begin{pmatrix}
A & B & C & D \\
\hdots & \hdots & \hdots & \hdots \\
q & w & e & r
\end{pmatrix}
\]

Note that the matrix fields that should be spanned must be empty, otherwise you get \LaTeX-errors.

Furthermore you can fill with the command \dotfill the rest of a line with dots. The effect of these commands is the same as with \hfill, see sec. 8.2.

For example the command A\dotfillB produces

A...........................................................................B

Similar to \dotfill there is for a line the command \hrulefill:

A...........................................................................B

To use the commands for text, they have to be inserted in \TeX mode.

4. Matrices

Matrices can be inserted via the math toolbar button \math or the menu Insert > Math > Matrix. In the matrix dialog you can specify the number of columns and rows, the alignment and the decoration. The vertical alignment is only of importance for matrices in inline formulas:

The first matrix is top \begin{pmatrix} A & D & G & J \end{pmatrix}, the second middle \begin{pmatrix} B & E & H & K \end{pmatrix} and the \begin{pmatrix} C & F & I & L \end{pmatrix},

third bottom \begin{pmatrix} A & D & G & J \\
B & E & H & K \\
C & F & I & L
\end{pmatrix} aligned.

The horizontal alignment specifies how the column entries should be aligned. It is set by entering a letter for every column. \texttt{l} denotes left aligned, \texttt{c} centered and \texttt{r} right aligned. To create for example a 4×4 matrix where the first column is left aligned, the second and third are centered and the last one is right aligned, one enters for the
horizontal alignment \texttt{lccr}. Normally in a matrix all columns are centered, therefore the default for every column is a \texttt{c}.

Horizontal alignment:

\begin{align*}
\text{lll} & : & 10000 & D & G & 10000 & D & G & 10000 & D & G \\
\text{ccc} & : & 10000 & B & H & 10000 & B & H & 10000 & B & H \\
\text{rrr} & : & 10000 & C & F & 10000 & C & F & 10000 & C & F
\end{align*}

To add or delete rows and columns subsequently, the math toolbar buttons etc., or the menu Edit $\triangleright$ Rows & Columns can be used. New rows can also be created with Ctrl+Return.

The \texttt{Decoration} adds parentheses in the selected style around the matrix. Alternatively, parentheses can be either be created with the commands \texttt{\left} and \texttt{\right} (shortcut Alt+M Parenthesis), see sec.5.1.2, or by using the following commands:

\begin{tabular}{|c|c|}
\hline
\texttt{Command} & \texttt{Result} \\
\hline
\texttt{\bmatrix} & \begin{bmatrix} 0 & -i \\ i & 0 \end{bmatrix} \\
\texttt{\Bmatrix} & \begin{bmatrix} 0 & -i \\ i & 0 \end{bmatrix} \\
\texttt{\pmatrix} & \begin{pmatrix} 0 & -i \\ i & 0 \end{pmatrix} \\
\hline
\texttt{\vmatrix} & \begin{vmatrix} 0 & -i \\ i & 0 \end{vmatrix} \\
\texttt{\Vmatrix} & \begin{vmatrix} 0 & -i \\ i & 0 \end{vmatrix} \\
\texttt{\matrix} & \begin{pmatrix} 0 & -i \\ i & 0 \end{pmatrix} \\
\hline
\end{tabular}

When e.g. \texttt{\vmatrix} is inserted, a blue box appears between two vertical lines where the matrix is inserted.

Note that decorated matrices ignore the vertical alignment.

As all multiline formulas are matrices, the length \texttt{\arraycolsep} that is described in sec.18.1.2 can also be used to change the column separation of matrices.

To change the row separation, the command \texttt{\arraystretch} is used. It is used as follows:

\texttt{\renewcommand{\arraystretch}{stretch factor}}

The command \texttt{\renewcommand} assigns the stretch factor to the predefined command \texttt{\arraystretch}. To double e.g. the row separation, use the factor 2. This is then used for all following matrices. To go back to the original separation, assign the factor 1 to \texttt{\arraystretch}.

To set matrices into a text line, the command \texttt{\smallmatrix} is used. When it is inserted a blue box with two dashed lines appears. In this box the matrix is inserted. This is a matrix \((\begin{array}{cc} A & B \\ C & D \end{array})\) in a text line.
5. Brackets and Delimiters

5.1. Vertical Brackets and Delimiters

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>(</td>
<td>)</td>
</tr>
<tr>
<td>{</td>
<td>}</td>
</tr>
<tr>
<td>[</td>
<td>]</td>
</tr>
<tr>
<td>\langle</td>
<td>\langle</td>
</tr>
<tr>
<td>\lceil</td>
<td>\lceil</td>
</tr>
<tr>
<td>\lfloor</td>
<td>\lfloor</td>
</tr>
<tr>
<td>/</td>
<td>|</td>
</tr>
<tr>
<td>|</td>
<td>|</td>
</tr>
</tbody>
</table>

Note: In \TeX{} mode the command `\textbackslash` must be used for the backslash, because the command `\\` produces a line break there.

For all characters listed above the size can be adjusted with the commands described in the following two subsections. When using these commands, the characters `<` and `>` can directly be used instead of the commands `\langle` and `\rangle`.

5.1.1. Manual Bracket Size

The bracket size can be specified manually by the \LaTeX-commands `\big`, `\Big`, `\bigg` and `\Bigg`. `\big` denotes the smallest and `\Bigg` the largest bracket size.

These commands are used to emphasize levels of brackets:

\[
\begin{align*}
\text{all brackets in the same size:} & \quad ((A + B)(A - B))^C \\
\text{this looks better:} & \quad (A + B)(A - B))^C
\end{align*}
\]

For the second formula the command `\Big((A+B)(A-B)\Big)^/uni2423C` has been used.

Here is an overview about all bracket sizes:

`\Bigg(\exp\bigg<\Big\{\big{\ln(3x)\big}^2\sin(x)\Big\}^A\bigg>_A\bigg)\bigg>\Bigg)^0,5`

\[
\left(\exp\left<\left[\left\{\ln(3x)\right]^2\sin(x)\right]\right]^A\right)^{0.5}
\]
Besides the \texttt{\big}-commands there is the variant \texttt{\bigm} that adds a bit more space between the bracket and its content, and the variant \texttt{\bigl-\bigr}, that don’t add additional space. The \texttt{l} at the end of the command \texttt{\bigl} is for a left bracket; for a right bracket this will be replaced by an \texttt{r}. A left or right bracket can each be an opening or closing bracket.

In the following table is a comparison of the variants:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\Bigm(\bigm(\ln(3x)\bigm)^2\Bigm)}</td>
<td>((\ln(3x))^2)</td>
</tr>
<tr>
<td>\texttt{\Big(\big(\ln(3x)\big)^2\Big)}</td>
<td>((\ln(3x))^2)</td>
</tr>
<tr>
<td>\texttt{\Bigl(\bigl(\ln(3x)\bigr)^2\Bigl)}</td>
<td>((\ln(3x))^2)</td>
</tr>
<tr>
<td>\texttt{\bigl(\ln(3x)\bigr)}</td>
<td>\ln(3x)</td>
</tr>
</tbody>
</table>

5.1.2. Automatic Bracket Size

Brackets with variable size can be inserted with the commands \texttt{\left} and \texttt{\right} or via the math toolbar button \texttt{[0]}. Directly behind \texttt{\left} and \texttt{\right} the wanted bracket must be inserted. The bracket size will then automatically be calculated for the output.

normal bracket: The command \texttt{\ln(\frac{A}{C})} creates \(\ln\left(\frac{A}{C}\right)\)

multiline bracket: The command \texttt{\ln\left(\frac{A}{C}\right)} creates \(\ln\left(\frac{A}{C}\right)\)

Instead of \texttt{\left} and \texttt{\right} the shortcut Alt+M Bracket can be used. This has the advantage that you can see in LyX immediately the real bracket size and that the matching right bracket will be created too.

The command for the last example would then be: \texttt{\ln Alt+M (\frac{A}{C})}

To omit a left or right bracket, a dot is inserted for the omitted bracket. For example the command \texttt{\left.\frac{A}{B}\right\}} creates:

\(\frac{A}{B}\)
The commands \texttt{\textbackslash left} and \texttt{\textbackslash right} will be converted by \LaTeX{} to brackets in the right size when the document is reloaded and an omitted bracket will appear as dashed line.

Because all popular \LaTeX{} distributions use e\TeX{}, an extension to \LaTeX{}, the command \texttt{\textbackslash middle} is additionally available for all brackets and limits. With this command the height of the following character is adapted to the one of the surrounding brackets, what is e.g. needed for physical vectors:

\[
\langle \phi \mid J = \frac{3}{2}, M_J \rangle
\]

For physical vectors there is a special \LaTeX{}-package, described in sec. 24.3.

### 5.2. Horizontal Brackets

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\overbrace} A+B \hat{\overbrace} \texttt{\overbrace} C \texttt{\underbrace} A+B \hat{\underbrace}</td>
<td>A+B \hat{A+B}</td>
</tr>
<tr>
<td>\texttt{\underbrace} A+B \hat{\underbrace} C \texttt{\overbrace} A+B \hat{\overbrace} C \texttt{\underbrace} A+B \hat{\underbrace}</td>
<td>A+B \hat{A+B}</td>
</tr>
</tbody>
</table>

In the last example it doesn’t matter if \texttt{\overbrace} or \texttt{\underbrace} is inserted at first.

If you set in the document settings under Math Options for the package \texttt{mathtools} the option \texttt{Load always}, you have access to square brackets:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\overbracket} A+B \hat{\overbracket} C \texttt{\underbracket} A+B \hat{\underbracket} C \texttt{\overbracket} A+B \hat{\overbracket} C \texttt{\underbracket} A+B \hat{\underbracket} C</td>
<td>A+B \hat{A+B}</td>
</tr>
</tbody>
</table>

For \texttt{\overbracket} and \texttt{\underbracket} you can change the thickness of the bracket’s stroke by specifying the desired thickness in square brackets behind the command:
When brackets should overlap each other, multiline formulas, as described in sec. 18, must be used:

\[
A = \underbrace{gggg + bbqq + dddd}_r \underbrace{dddd}_s
\]

In the first row the formula is inserted together with the first brace. It is hereby important that the space command\footnote{Space commands are explained in sec. 8.1.} \(\backslash: \) is inserted before the first d, because the brace that ends behind the q prevents that the following “+” is surrounded by space.\footnote{because a bracket is not handled as a character, see sec. 10.4} In the second row the second brace is inserted. As it should begin before the b, first the command \texttt{\hphantom{gggg+:\}} is inserted.\footnote{more about \texttt{\hphantom} see sec. 3.7} This space is needed because the “+” is also surrounded by space in the formula. The brace is placed under the command \texttt{\hphantom{bbqq+dddd}}.

It gets more complicated when brackets overlap each other above and under the formula, like in the following example:

\[
A = \underbrace{gggg + bbqq + dddd}_r \underbrace{dddd}_s
\]

The first formula row is the same as the second row of the previous example, with the difference that the brace is above. The second row contains the formula together with the second brace. To avoid that there is space between the upper brace in the first row and the formula, the row spacing needs to be reduced. This is not easily possible due to a bug in LyX.\footnote{LyX-bug \#1505} As a solution for the problem, the global formula row separation \texttt{\setlength{\jot}{-6pt}} in TeX mode. \texttt{\jot} is set back after the formula to the standard value of 3 pt using the same command. More about the row separation in formulas is explained in sec. 18.1.1.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\overbracket[3pt]{A+B} \quad 3 \underbracket[1pt]{A+B} \quad 5</td>
<td>A + B</td>
</tr>
</tbody>
</table>

\footnotetext[12]{Space commands are explained in sec. 8.1.}
\footnotetext[13]{because a bracket is not handled as a character, see sec. 10.4}
\footnotetext[14]{more about \texttt{\hphantom} see sec. 3.7}
\footnotetext[15]{LyX-bug \#1505}
6. Arrows

Arrows can be inserted via the math toolbar button $\leftarrow$ or the commands listed in the following subsections.

6.1. Horizontal Arrows

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{	extbackslash gets}$</td>
<td>$\leftarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash Leftarrow}$</td>
<td>$\Leftarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash longleftarrow}$</td>
<td>$\longrightarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash Longleftarrow}$</td>
<td>$\Longleftarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash leftharpoonup}$</td>
<td>$\leftharpoonup$</td>
</tr>
<tr>
<td>$\text{	extbackslash leftharpoondown}$</td>
<td>$\leftharpoondown$</td>
</tr>
<tr>
<td>$\text{	extbackslash hookleftarrow}$</td>
<td>$\hookleftarrow$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{	extbackslash to}$</td>
<td>$\rightarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash Rightarrow}$</td>
<td>$\Rightarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash longrightarrow}$</td>
<td>$\Longrightarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash Longrightarrow}$</td>
<td>$\Longleftrightarrow$</td>
</tr>
<tr>
<td>$\text{	extbackslash rightharpoonup}$</td>
<td>$\rightharpoonup$</td>
</tr>
<tr>
<td>$\text{	extbackslash rightharpoondown}$</td>
<td>$\rightharpoondown$</td>
</tr>
<tr>
<td>$\text{	extbackslash hookrightarrow}$</td>
<td>$\hookrightarrow$</td>
</tr>
</tbody>
</table>

Arrows used as accents like e.g. vector arrows are listed in sec. 7.

Furthermore there are the labeled arrows $\text{	extbackslash xleftarrow}$ and $\text{	extbackslash xrightarrow}$. When inserting one of these commands in a formula, an arrow with two blue boxes appear where the label can be inserted. The length of the arrow adapts to the label width.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$F(a) \text{	extbackslash xleftarrow}_{x=a \downarrow x&gt;0} \rightarrow F(x)$</td>
<td>$F(a) \xleftarrow[\leftarrow]_{x&gt;0} F(x)$</td>
</tr>
<tr>
<td>$F(x) \text{	extbackslash xrightarrow}_{x=a \downarrow x&gt;0} \rightarrow F(a)$</td>
<td>$F(x) \xrightarrow[\rightarrow]_{x&gt;0} F(a)$</td>
</tr>
</tbody>
</table>

If you set in the document settings under Math Options for the package mathtools the option Load always, you have access to the following labeled arrows:
<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>\xleftarrow</td>
<td>( x&gt;0 \xleftarrow{x=a} )</td>
<td>\xleftharpoonondown</td>
<td>( x&gt;0 \xleftharpoonondown{x=a} )</td>
</tr>
<tr>
<td>\xLeftarrow</td>
<td>( x&gt;0 \xLeftarrow{x=a} )</td>
<td>\xleftharpoonup</td>
<td>( x&gt;0 \xleftharpoonup{x=a} )</td>
</tr>
<tr>
<td>\xRightarrow</td>
<td>( x&gt;0 \xRightarrow{x=a} )</td>
<td>\xrightharpoonondown</td>
<td>( x&gt;0 \xrightharpoonondown{x=a} )</td>
</tr>
<tr>
<td>\xleftharpoons</td>
<td>( x&gt;0 \xleftharpoons{x=a} )</td>
<td>\xleftharpoonup</td>
<td>( x&gt;0 \xleftharpoonup{x=a} )</td>
</tr>
<tr>
<td>\xhookleftarrow</td>
<td>( x&gt;0 \xhookleftarrow{x=a} )</td>
<td>\xllefttharapoons</td>
<td>( x&gt;0 \xllefttharapoons{x=a} )</td>
</tr>
<tr>
<td>\xhookrightarrow</td>
<td>( x&gt;0 \xhookrightarrow{x=a} )</td>
<td>\xrightharpoonup</td>
<td>( x&gt;0 \xrightharpoonup{x=a} )</td>
</tr>
</tbody>
</table>

The command scheme is for all these arrows:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>( F(a) \xleftarrow{x=a} { x&gt;0 \rightarrow F(x) )</td>
<td>( F(a) \xleftarrow{x=a} { x&gt;0 \rightarrow F(x) )</td>
</tr>
</tbody>
</table>

### 6.2. Vertical and diagonal Arrows

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\uparrow</td>
<td>↑</td>
<td>\nearrow</td>
<td>↑</td>
</tr>
<tr>
<td>\Uparrow</td>
<td>↑</td>
<td>\searrow</td>
<td>↓</td>
</tr>
<tr>
<td>\updownarrow</td>
<td>↑</td>
<td>\swarrow</td>
<td>↓</td>
</tr>
<tr>
<td>\Downarrow</td>
<td>↓</td>
<td>\nwarrow</td>
<td>↓</td>
</tr>
</tbody>
</table>

Vertical arrows can be used also as delimiters together with the commands described in sec. 5.1.1 and sec. 5.1.2.

### 7. Accents

Accents can be inserted via the math toolbar button  or the commands listed in the following subsections.
7.1. Accents for one Character

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\dot{A}</td>
<td>\ddot{A}</td>
</tr>
<tr>
<td>\ddot{A}</td>
<td>\dddot{A}</td>
</tr>
<tr>
<td>\dddot{A}</td>
<td>\dddot{A}</td>
</tr>
<tr>
<td>\vec{A}</td>
<td>\vec{A}</td>
</tr>
<tr>
<td>\bar{A}</td>
<td>\bar{A}</td>
</tr>
<tr>
<td>\mathring{A}</td>
<td>\mathring{A}</td>
</tr>
</tbody>
</table>

You can directly insert accents like é to formulas. LyX will transform them to the corresponding accent command. For umlauts it is better to insert a quotation mark before the vowel. These two characters are then treated by \LaTeX as one character when the formula part with the umlaut is marked as German. In contrary to \ddot{A}, with this method “real” umlauts are created as demonstrated in the following example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>“i</td>
<td>\ddot{i}</td>
</tr>
</tbody>
</table>

Another advantage to \ddot{A} is that umlauts can directly be converted to mathematical text because the accent commands above are not allowed in mathematical text. To convert an accented character to mathematical text, only the character under the accent may be converted. This applies also for all other conversions, e.g. to italic or bold.

In mathematical text, umlauts and other accented characters can directly be inserted.

LyX also supports a tilde under the character if the \LaTeX-package undertilde is installed on your system:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\utilde{A}</td>
<td>\utilde{A}</td>
</tr>
</tbody>
</table>

\footnote{accents in text see sec. 16.2}
7.2. Accents for several Characters

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\overleftarrow{A=B}</td>
<td>$\overleftarrow A = \overleftarrow B$</td>
</tr>
<tr>
<td>\underleftarrow{A=B}</td>
<td>$\underleftarrow A = \underleftarrow B$</td>
</tr>
<tr>
<td>\overleftrightarrow{A=B}</td>
<td>$\overleftrightarrow A = \overleftrightarrow B$</td>
</tr>
<tr>
<td>\underleftrightarrow{A=B}</td>
<td>$\underleftrightarrow A = \underleftrightarrow B$</td>
</tr>
</tbody>
</table>

\[\overrightarrow{A=B}\]
\[\underrightarrow{A=B}\]
\[\widetilde{A=B}\]
\[\widehat{A=B}\]

With these commands as many characters as you like can be accented. But the accents $\widetilde{\text{widetilde}}$ and $\widehat{\text{widehat}}$ will only be set in the output with a length of three characters, as shown in the following example:

\[A + \widetilde{B} = C - D\]

With the commands $\overset{\text{overset}}{\text{overset}}$ and $\underset{\text{underset}}{\text{underset}}$ described in the previous subsection it is also possible to accent several characters. The command $\text{\overset{\text{overset}}{\text{overset}}}_{A=B} \downarrow \cdots$ creates:

\[A = B\]

8. Space

8.1. Predefined Space

Sometimes it is necessary to insert horizontal space into a formula. This is done by inserting a protected space (shortcut indéfini). A “\hspace{1em}” appears and by pressing Space several times one can select one of eight different space sizes. The spaces can also be inserted using the math toolbar button or special commands. Independent from the inserted command, one can select the size again by pressing Space afterwards.

<table>
<thead>
<tr>
<th>Command</th>
<th>Number of Space keystrokes</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>,</td>
<td>0</td>
<td>$A , B$</td>
</tr>
<tr>
<td>:</td>
<td>1</td>
<td>$A , B$</td>
</tr>
<tr>
<td>;</td>
<td>2</td>
<td>$A , B$</td>
</tr>
<tr>
<td>\quad</td>
<td>3</td>
<td>$A , B$</td>
</tr>
<tr>
<td>\qquad</td>
<td>4</td>
<td>$A , B$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Number of Space keystrokes</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\hfill</td>
<td>5</td>
<td>$A \quad B$</td>
</tr>
<tr>
<td>\hspace{1em}</td>
<td>6</td>
<td>$A \quad B$</td>
</tr>
<tr>
<td>\hspace{1em}</td>
<td>7</td>
<td>$A \quad B$</td>
</tr>
<tr>
<td>\quad</td>
<td>8</td>
<td>$A \quad B$</td>
</tr>
<tr>
<td>!</td>
<td>9</td>
<td>$A \quad B$</td>
</tr>
</tbody>
</table>
Space 5–7 are variable spaces which are explained in sec. 8.2. Space 9 seems to produce no space. It is displayed red in LyX contrary to the other sizes, because it is a negative space. There are two more negative spaces:

<table>
<thead>
<tr>
<th>Command</th>
<th>\negmedspace</th>
<th>\negthickspace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of <strong>Space</strong> keystrokes after inserting the protected space</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td><strong>Result</strong></td>
<td><strong>AB</strong></td>
<td><strong>AB</strong></td>
</tr>
</tbody>
</table>

Negative spaces can lead to characters overlapping each other. Thus they can be used to enforce ligatures, which are e.g. useful for summation operators:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\sum\sum_{f_{kl}}</td>
<td>$\sum\sum f_{kl}$</td>
</tr>
<tr>
<td>\sum\negmedspace\sum_{f_{kl}}</td>
<td>$\sum\sum f_{kl}$</td>
</tr>
</tbody>
</table>

Relations like for example equal signs, are always surrounded by space. To suppress this, the equal sign is placed into a TeX brace. The following example demonstrates this:

- normal equation: $A = B$
- equation without space: $\{=\rightarrow B$

The command for the last formula is: **A\{=\rightarrow B**

Spaces are needed for physical units, because the space between the value and the unit is the smallest one and not a normal space. For units in text, the smallest space is inserted via the menu **Insert > Formatting > Thin Space** (shortcut Ctrl+Shift+Space). An example to visualize the difference:

- 24 kW·h space between value and unit
- 24kW·h smallest space between value and unit

### 8.2. Variable Space

Space with a defined length can be inserted with the command **\hspace**. Then a long “ ” appears. The length can be specified by left-clicking on the “ ”. The length may also be negative. When a space would be the first character in a line it would be omitted. To force its output use the command **\hspace*** instead of **\hspace** or left-click on the “ ” and check the option **Protect**.

To insert as much space as is available, the command **\hfill** is used.

---

17 for vertical space in formulas see sec. 18.1.1
In the last example the available space is given by the longest column entry of the table. In an inline formula the space depends on the length of the line in which \hfill is inserted. Thus, when the line uses the full width, no space will be created. \hfill only has an effect on displayed formulas when the formula style Indented is used. (Formula styles are explained in sec. 17.)

Besides \hfill, there are the commands \dotfill and \hrulefill that fill the space with a pattern, see sec. 3.9 for an example.

For text, variable space can be inserted via the menu Insert ➤ Formatting ➤ Horizontal Space:

This is a line with 2 cm space.

This is a line with maximum space.

8.3. Space besides inline Formulas

The space that surrounds inline formulas can be adjusted with the length \texttt{mathsurround}. The value of a length is set with the command \texttt{setlength} which has the following scheme:

\begin{verbatim}
\setlength{length name}{value}
\end{verbatim}

To set \texttt{mathsurround} to the value 5 mm, the command

\begin{verbatim}
\setlength{\texttt{mathsurround}}{5mm}
\end{verbatim}

is inserted in \TeX{} mode. 5 mm space will now be set around all inline formulas:

This is a line with an inline formula $A = B$ with 5 mm surrounding space.

To return to the predefined value, \texttt{mathsurround} is set to the value 0 pt.
9. Boxes and Frames

Boxes for text are described in chapter Boxes in the Embedded Objects manual.

9.1. Boxes with Frame

It is possible to frame a formula or part of one with the commands \texttt{\fbox} and \texttt{boxed}.

When one of these commands is inserted in a formula, a blue box appears within a frame to enter formula parts. For \texttt{\fbox} an additional formula has to be created by \texttt{Ctrl+M} within this box, because the box content will otherwise be treated as mathematical text. When \texttt{boxed} is used, a new formula is automatically created inside the frame.

The command \texttt{\fbox} is not suitable to frame displayed formulas because the formula will always be set in the size of the text. \texttt{boxed} is in contrary not suitable to frame inline formulas, because the formula will always be set in the size of a displayed formula.

An extension to \texttt{\fbox} is the command \texttt{\framebox} where additionally the frame width and the alignment can be specified. \texttt{\framebox} is used in the following scheme:

\texttt{\framebox[frame width][position]{box content}}

The position can either be \texttt{l} or \texttt{r}. \texttt{l} left aligns, \texttt{r} right aligns the formula in the box. When no position is given, the formula will be centered.

If no width is given, also no position can be given. In this case the frame width is adjusted to the box content like for \texttt{\fbox}.

When the command \texttt{\framebox} is inserted, a box appears containing three blue boxes. The first two boxes are surrounded by brackets and denote the two optional arguments. The third box is for formula parts like for \texttt{\fbox}.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\fbox.\texttt{Ctrl+M \int_A=B}</td>
<td>$\int A = B$</td>
</tr>
<tr>
<td>\boxed.\texttt{int_A=B}</td>
<td>$\int A = B$</td>
</tr>
<tr>
<td>A+\fbox.B</td>
<td>$A + \texttt{B}$</td>
</tr>
<tr>
<td>\framebox.20mm→→\texttt{Ctrl+M frac_A\downarrow B}</td>
<td>$\frac{A}{B}$</td>
</tr>
</tbody>
</table>

The frame thickness can also be adjusted. To do this the following commands have to be inserted in \texttt{\LaTeX} mode before the formula
\fboxrule “thickness” \fboxsep “distance”

“distance” specifies the minimal distance between the frame and the first character
in the box. An example for this is the following framed formula:

\[ \fbox{A + B = C} \]

Before this formula the commands

\fboxrule 2mm \fboxsep 3mm

were inserted in \TeX{} mode. The given values are used for all following boxes.
To return to the standard frame size, the command

\fboxrule 0.4pt \fboxsep 3pt

is inserted in \TeX{} mode before the next formula.

9.2. Boxes without Frame

For boxes without a frame there are the following box commands: \texttt{\mbox}, \texttt{\makebox} and \texttt{\raisebox}

With \texttt{\raisebox} a box can be super- or subscripted. But in contrary to normal
super- and subscripting, the characters in the box keep their font size. \texttt{\raisebox} is
used in the following scheme:

\[ \texttt{\raisebox{height}\{box content\}} \]

When the box should contain a formula, an extra formula is needed like for \texttt{\fbox}. \textbf{Note:} For \texttt{\raisebox} this extra formula is created by pressing \texttt{Ctrl+M} twice instead of once because \texttt{I\TeX} doesn’t yet support \texttt{\raisebox} directly.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>H\raisebox{2mm→}{al→ lo}</td>
<td>( H^{al}_{lo} )</td>
</tr>
<tr>
<td>H\raisebox{-2mm→}{al→ lo}</td>
<td>( H^{al}_{lo} )</td>
</tr>
</tbody>
</table>
| A=\raisebox{-2mm→}{Ctrl+M Ctrl+M \sqrt{\text{B}}} | \( A = \sqrt{B} \)

The command \texttt{\mbox} is equivalent to \texttt{\fbox} and \texttt{\makebox} is equivalent to \texttt{\framebox}, with the difference that there is no frame.
9.3. Colored Boxes

To be able to use all commands explained in this section, the \LaTeX-package \texttt{color}\footnote{The \LaTeX-package \texttt{color} is part of every \LaTeX standard installation.} has to be loaded in the \LaTeX-preamble with the line\footnote{When text is colored somewhere in the document with a predefined color, LYX loads the \LaTeX package \texttt{color} automatically. Thus it is possible that the package is loaded twice, but this does not cause problems.}

\texttt{\usepackage{color}}

To color boxes, the command \texttt{\colorbox} is used in the following scheme:

\texttt{\colorbox{color}{box content}}

The box content can also be a box and a \texttt{\colorbox} can also be part of another box (see the 2nd and 3rd example). When the box should contain a formula, an extra formula has to be created, the same way as for \texttt{\raisebox}.\footnote{This also applies for the command \texttt{fcolorbox}.}

One of the following predefined colors can be chosen:

\texttt{black, blue, cyan, green, magenta, red, white} and \texttt{yellow}

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\colorbox{yellow}{A=B}}</td>
<td>\texttt{A=B}</td>
</tr>
<tr>
<td>\texttt{\colorbox{green}{\fbox A=B}}</td>
<td>\texttt{[A=B]}</td>
</tr>
<tr>
<td>\texttt{\fbox/\colorbox{green}{\int C=D}}</td>
<td>\texttt{\int C=D}</td>
</tr>
</tbody>
</table>

\texttt{\colorbox} only colors the box but not the characters in the box. To color all characters, the whole formula is highlighted and the desired color is chosen in the \texttt{Text Style} dialog. The dialog can be called with the toolbar button \texttt{\hspace{1em}} or the menu \texttt{Edit \hspace{1em} Text Style \hspace{1em} Customized}. The formula number then has the same color as the formula. When the formula number should get another color than the formula characters, the color must be changed within the formula.

An example:

\[
\int A = B \quad (1)
\]

\[
\int A = B \quad (2)
\]
Formula (1) is completely colored red.
Formula (2) was first completely colored green to set the color for the formula number. Subsequently the formula characters were colored red.

To color the frame different than the rest of the box, the command $\texttt{\textbackslash fcolorbox}$ is used in the following scheme:

$\texttt{\textbackslash fcolorbox\{frame color\}\{color\}\{box content\}}$

So $\texttt{\textbackslash fcolorbox}$ is an extension of the command $\texttt{\textbackslash colorbox}$. The frame width is set, like for $\texttt{\textbackslash framebox}$, with $\texttt{\textbackslash fboxrule}$ and $\texttt{\textbackslash fboxsep}$. An example:

$$A=B$$

This formula was created with the command $\texttt{\textbackslash fcolorbox\{cyan\}→\{magenta\}→\{A=B\}}$.

To use other colors than the predefined ones, they have to be defined first.
One can for example define the color “darkgreen” with the $\LaTeX$-preamble line:

$$\texttt{\textbackslash definecolor\{darkgreen\}\{cmyk\}\{0.5, 0, 1, 0.5\}}$$

$cmyk$ is the color space that denotes the colors cyan, magenta, yellow and black. The four comma separated numbers are the portion factor for the corresponding colors of the color space. The factors can be in the range of 0-1. Instead of $cmyk$ also the color space $rgb$ can be used for definitions. $rgb$ denotes red, green and blue, so that there are in this case three portion factors for the corresponding colors. Furthermore there is the color space gray with one portion factor for the gray value.

As example a framed box with the new defined color darkgreen where the characters have been colored yellow:

$$\int A\,dx = \sqrt[5]{B} \ln \left( \frac{1}{3} \right)$$

Self-defined colors can also be used for text with the help of the command $\texttt{\textbackslash textcolor}$: This sentence is “darkgreen”.

$\texttt{\textbackslash textcolor}$ is used in the scheme $\texttt{\textbackslash textcolor\{color\}\{characters to color\}}$.

9.4. Paragraph Boxes

A box that can contain several lines and paragraphs, a so-called paragraph box (parbox), can be created with the menu $\textbf{Insert}→\textbf{Box}$ or the toolbar button \[.\]
The following example shows a framed parbox in a line:
This is a paragraph box. It is exactly 5 cm long and can also contain formulas: \[ \int A \, ds = C \]

with a parbox.

Such a box is created by right-clicking on the gray box inset. A dialog pops up showing the box properties. In our case set: Decoration: Rectangular box, Inner Box: Parbox, Width: 5 cm, Vertical Box Alignment: Middle

In LaTeX a parbox is created with the command \texttt{\textbackslash parbox} which has the following scheme:

\texttt{\parbox[position]{width}{box content}}

The positions \texttt{b} and \texttt{t} are possible. \texttt{b} for “bottom” means that the box is aligned within the surrounding text with its last line. With \texttt{t} for “top” this is done with the first line. When no position is given, the box will be vertically centered, see section Boxes of the Embedded Objects manual for examples.

To frame formulas completely, including the formula number, the formula must be set into a parbox. To do this, the command \texttt{\fbox{\parbox{\linewidth-2\fboxsep-2\fboxrule}{}}} is inserted in \LaTeX{} mode before the formula. \texttt{\linewidth} is hereby the line width set for the document. Because the frame is outside the parbox, 2 times the frame separation and the frame thickness must be subtracted from the line width. To be able to multiply and subtract in arguments, the \LaTeX{}-package \texttt{calc}\textsuperscript{21} must be loaded in the \LaTeX{}-preamble with the line

\texttt{\usepackage{calc}}

Behind the formula both boxes are closed by entering \texttt{\}}} in \LaTeX{} mode. Here is an example:

\[ \int A \, dx = \frac{\sqrt[3]{B}}{\ln \left( \frac{1}{3} \right)} \]  

(4)

As a parbox is used as the argument of \texttt{\fbox}, there is in this case no difference between \texttt{\fbox} and \texttt{boxed}.

Paragraph boxes are very useful to comment formulas directly. To do this, \texttt{\parbox} is used in combination with the command \texttt{\tag}. (more about \texttt{\tag} see sec. 19.4)

\textsuperscript{21}calc is part of every \LaTeX{} standard installation.
An example of a formula commented with \texttt{parbox}:

\[
5x - 7b = 3b
\]

This is a description. It is distinctly separated from the formula and multiline.

Such a formula must be inserted completely in \TeX\ mode because \LaTeX\ does not yet support the command \texttt{parbox} in formulas. The formula is created with the following command sequence:

The command \texttt{\[5x-7b=3b\tag*{\parbox{5cm}{\text{is a description. It is distinctly separated from the formula and multiline.}}}\]} is inserted in \TeX\ mode. Then the description follows as normal text and finally \texttt{\]} is inserted in \TeX\ mode. The commands \texttt{\[} and \texttt{\]} hereby create a displayed formula.

The advantages of \texttt{parbox} can be seen in this example that was “commented” using the mathematical textmode:

\[
5x - 7b = 3b
\]

This is a description. It is not separated from the formula ...

10. Operators

10.1. Big Operators

To be able to use all integral operators listed here, the option \texttt{Use esint package automatically} must be set in the document settings under \texttt{Math Options}.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\int}</td>
<td>\texttt{\int}</td>
<td>\texttt{\sum}</td>
<td>\texttt{\sum}</td>
</tr>
<tr>
<td>\texttt{\oint}</td>
<td>\texttt{\oint}</td>
<td>\texttt{\prod}</td>
<td>\texttt{\prod}</td>
</tr>
<tr>
<td>\texttt{\ointclockwise}</td>
<td>\texttt{\ointclockwise}</td>
<td>\texttt{\coprod}</td>
<td>\texttt{\coprod}</td>
</tr>
<tr>
<td>\texttt{\sqint}</td>
<td>\texttt{\sqint}</td>
<td>\texttt{\bigodot}</td>
<td>\texttt{\bigodot}</td>
</tr>
<tr>
<td>\texttt{\fint}</td>
<td>\texttt{\fint}</td>
<td>\texttt{\bigotimes}</td>
<td>\texttt{\bigotimes}</td>
</tr>
<tr>
<td>\texttt{\landupint}</td>
<td>\texttt{\landupint}</td>
<td>\texttt{\bigoplus}</td>
<td>\texttt{\bigoplus}</td>
</tr>
<tr>
<td>\texttt{\landdownint}</td>
<td>\texttt{\landdownint}</td>
<td>\texttt{\bigwedge}</td>
<td>\texttt{\bigwedge}</td>
</tr>
<tr>
<td>\texttt{\bigcap}</td>
<td>\texttt{\bigcap}</td>
<td>\texttt{\bigvee}</td>
<td>\texttt{\bigvee}</td>
</tr>
<tr>
<td>\texttt{\bigcup}</td>
<td>\texttt{\bigcup}</td>
<td>\texttt{\bigsqcup}</td>
<td>\texttt{\bigsqcup}</td>
</tr>
<tr>
<td>\texttt{\biguplus}</td>
<td>\texttt{\biguplus}</td>
<td>\texttt{\bigsqcup}</td>
<td>\texttt{\bigsqcup}</td>
</tr>
</tbody>
</table>

All big operators can also be inserted via the math toolbar button \texttt{\int}.

\textsuperscript{22}When the formula style \texttt{Indented} is used, \texttt{\tag*{\{} can also be replaced by \texttt{\hfill}. (formula styles see sec. 17)
The operators are called big because they are bigger than the sometimes equal looking binary operators. All big operators can have limits as described in the next subsection.

For all integral operators there is a second version available, ending in \texttt{\textbackslash intop}, \texttt{\textbackslash ointop} etc.. These operators are different from \texttt{\textbackslash int} etc. in the style the operator limits are displayed, see sec. 10.2.

**Advice for Integrals**

The letter \textit{d} in an integral is an operator, that therefore has to be set upright. This is done by highlighting the \textit{d} and using the keyboard shortcut \texttt{Alt+C R}. Finally the smallest space is inserted before the \textit{d}, as this is usual for operators. An example:

incorrect: \( \int A(x)dx \)

correct: \( \int A(x) \, dx \)

For multiple integrals there are the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\int}</td>
<td>( \int )</td>
</tr>
<tr>
<td>\texttt{\oiint}</td>
<td>( \oiint )</td>
</tr>
<tr>
<td>\texttt{\sqiint}</td>
<td>( \sqiint )</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\iiint}</td>
<td>( \iiint )</td>
</tr>
<tr>
<td>\texttt{\iiiint}</td>
<td>( \iiiint )</td>
</tr>
<tr>
<td>\texttt{\dotsint}</td>
<td>( \ldots \int )</td>
</tr>
</tbody>
</table>

**10.2. Operator Limits**

Limits are created by super- and subscripts:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\prod} \texttt{\textbackslash infty} \rightarrow \texttt{__} \rightarrow \texttt{_0} \rightarrow \texttt{A(x)}</td>
<td>( \prod_0^\infty A(x) )</td>
</tr>
</tbody>
</table>

Limits of inline formulas are set right beside the operator. Limits in displayed formulas are set above or below the operator, except for integral limits.

To force that the limits are set beside the operator, the cursor is set directly behind the operator and the limits type is changed with the menu \texttt{Edit} \rightarrow \texttt{Math} \rightarrow \texttt{Change Limits Type} to \texttt{Inline} (shortcut \texttt{Alt+M L}). An example:

The default limits type is this:

\[ \sum_{x=0}^{\infty} \frac{1}{x^2} \]

\textsuperscript{23}Font styles see sec. 11.1
This is how it looks when the limits type was changed to **Inline**:

\[
\sum_{x=0}^{\infty} \frac{1}{x^2}
\]

For integrals, except those ending with \texttt{op} like \texttt{\intop}, \texttt{\ointop} etc., the limits are by default set beside the operator. But for multiple integrals the limits are often set below the operator. In the following example the limits type was therefore set to **Display** and so set below the integrals:

\[
\iiint_V X \, dV = U
\]  

(5)

To specify conditions for limits, the commands \texttt{\subarray} and \texttt{\substack} are used.

To create for example this expression

\[
\sum_{\begin{subarray}{l} 0<k<1000 \\ k \in \mathbb{N} \end{subarray}} n^2
\]

the following has to be done:

First the command \texttt{\sum\_n\_} is typed in. One is now in a blue box under the summation operator and insert there the command \texttt{\subarray}. The blue box is now within a purple box and now several lines can be written among each other. A new line is created by inserting a line break (Ctrl+Return). When now \texttt{0<k<1000 Ctrl+Return} is typed in, a new box appears below for the new line.

The alignment of the lines can be changed to left aligned with the table toolbar or the menu **Edit**>**Rows &Columns**. To get right alignment, \texttt{\hfill} is inserted at the beginning of the line.

The command \texttt{\substack} is equivalent to \texttt{\subarray} with the difference that the lines are always centered.

Like in formula (6) there can be too much space beside an operator, because the characters following the operator are set beside the limits. To avoid this the command \texttt{\smashoperator} can be used. To activate it, set in the document settings under **Math Options** for the package **mathtools** the option **Load always**. \texttt{\smashoperator} sets the space besides the operator to 0 pt.

Applied on formula (6), one uses the command

\texttt{\smashoperator{}}

and inserts the operator with its limits into the braces. Behind the brace one continues the formula:

\[
\sum_{\begin{subarray}{l} 0<k<1000 \\ k \in \mathbb{N} \end{subarray}} n^2
\]

29
It is possible to set the space of only one side of the operator to 0 pt. To do this write either \emph{\[l\]} or \emph{\[r\]} between \texttt{\textbackslash smashoperator} and its brace. \texttt{l} stands for the left and \texttt{r} for the right side of the operator. Here is an example of the possible \texttt{\textbackslash smashoperator} forms:

\[
\begin{align*}
Y_1 \sum_{1 \leq i \leq j \leq n} X_{ij} &= Y_1 \sum_{1 \leq i \leq j \leq n} X_{ij} = Y_1 \sum_{1 \leq i \leq j \leq n} X_{ij}
\end{align*}
\]

When several consecutive operators have limits the typesetting of the limits looks often imperfect in the output, see this example:

\[
\begin{align*}
\text{a) } \lim_{n \to \infty} \max_{p \geq n} & \text{ b) } \lim_{n \to \infty} \max_{p^2 \geq n} \\
\text{c) } \lim_{n \to \infty} \sup_{p^2 \geq n} & \text{ d) } \lim_{n \to \infty} \max_{p \geq n}
\end{align*}
\]

To improve the typesetting set in the document settings under \texttt{Math Options} for the package \texttt{mathtools} the option \texttt{Load always}. Then insert into your formula the command \texttt{\textbackslash adjustlimits} directly before the first operator. The example will then look like this:

\[
\begin{align*}
\text{a) } \lim_{n \to \infty} \max_{p \geq n} & \text{ b) } \lim_{n \to \infty} \max_{p^2 \geq n} \\
\text{c) } \lim_{n \to \infty} \sup_{p^2 \geq nK} & \text{ d) } \lim_{n \to \infty} \max_{p \geq n}
\end{align*}
\]

How to use one limit for several operators is described in sec. 10.5.

\section*{10.3. Decoration for Operators}

With the commands \texttt{\textbackslash overset} and \texttt{\textbackslash underset} characters can be placed above or below an operator, respectively. With the command \texttt{\textbackslash sideset} characters can be set before and behind a big operator.

There are 4 variants of \texttt{\textbackslash sideset}:

\begin{itemize}
  \item \texttt{\textbackslash sideset} is used to set characters at the corners of the operator
  \item \texttt{\textbackslash sidesetn} is used to set characters before and/or behind the operator (this variant represents \texttt{\LaTeX}'s original \texttt{\textbackslash sideset} command)
  \item \texttt{\textbackslash sidesetl} is used to set characters at the left corners and/or behind the operator
  \item \texttt{\textbackslash sidesetr} is used to set characters at the right corners and/or before the operator
\end{itemize}

For example the command \texttt{\textbackslash sidesetn\textbackslash sum\textbackslash \rightarrow\rightarrow_k=1\textbackslash \cap n} produces:

\[
\sum_{k=1}^{n'}
\]
Note: \textbackslash{\texttt{\textbackslash sideset} can only be used to decorate big operators, binary operators are not allowed.

\textbackslash{\texttt{\textbackslash overset} and \textbackslash{\texttt{\textbackslash underset} can also be used to decorate symbols and characters. For example, the command \textbackslash{\texttt{\textbackslash overset\textbackslash{\texttt{\maltese}}\textbackslash{\texttt{\textbackslash a}}} produces:}

\[ \text{\textbullet} \]

10.4. Binary Operators

Binary operators are surrounded by space when there is a character before and after them.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
<th>Command</th>
<th>Result</th>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>+</td>
<td>\textbackslash{nabla}</td>
<td>\textbackslash{\nabla}</td>
<td>\textbackslash{\texttt{\textbackslash oplus}}</td>
<td>\oplus</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>\textbackslash{\texttt{\textbackslash bigtriangledown}}</td>
<td>\textbackslash{\bigtriangledown}</td>
<td>\textbackslash{\texttt{\textbackslash ominus}}</td>
<td>\ominus</td>
</tr>
<tr>
<td>\textbackslash{\pm}</td>
<td>±</td>
<td>\textbackslash{\texttt{\textbackslash bigtriangleup}}</td>
<td>\textbackslash{\bigtriangleup}</td>
<td>\textbackslash{\texttt{\textbackslash otimes}}</td>
<td>\otimes</td>
</tr>
<tr>
<td>\textbackslash{\mp}</td>
<td>±</td>
<td>\texttt{Box}</td>
<td>\Box</td>
<td>\textbackslash{\texttt{\textbackslash oslash}}</td>
<td>\otimes</td>
</tr>
<tr>
<td>\textbackslash{\texttt{\textbackslash cdot}}</td>
<td>•</td>
<td>\texttt{cap}</td>
<td>\cap</td>
<td>\texttt{odot}</td>
<td>\odot</td>
</tr>
<tr>
<td>\textbackslash{\texttt{\textbackslash times}}</td>
<td>×</td>
<td>\texttt{cup}</td>
<td>\cup</td>
<td>\texttt{amalg}</td>
<td>\amalg</td>
</tr>
<tr>
<td>\texttt{\textbackslash div}</td>
<td>÷</td>
<td>\texttt{dagger}</td>
<td>\dagger</td>
<td>\text{\texttt{\textbackslash setminus}}</td>
<td>\setminus</td>
</tr>
<tr>
<td>\texttt{*}</td>
<td>*</td>
<td>\texttt{ddagger}</td>
<td>\ddagger</td>
<td>\texttt{\textbackslash {\texttt{sqcap}}}</td>
<td>\sqcap</td>
</tr>
<tr>
<td>\texttt{\star}</td>
<td>*</td>
<td>\texttt{wr}</td>
<td>\wr</td>
<td>\texttt{\textbackslash {\texttt{sqcup}}}</td>
<td>\sqcup</td>
</tr>
<tr>
<td>\texttt{\diamond}</td>
<td>◊</td>
<td>\texttt{wedge}</td>
<td>\wedge</td>
<td>\texttt{\textbackslash triangleleft}</td>
<td>\triangleleft</td>
</tr>
<tr>
<td>\texttt{\textbullet}</td>
<td>•</td>
<td>\texttt{vee}</td>
<td>\vee</td>
<td>\texttt{\textbackslash triangleright}</td>
<td>\triangleright</td>
</tr>
</tbody>
</table>

All binary operators can also be inserted via the math toolbar button \texttt{±}.

To typeset the Laplace operator also \textbackslash{\texttt{\textbackslash Delta}} or \textbackslash{\texttt{\textbackslash nabla} \textbackslash{\texttt{\textbackslash ^2}}} (\textbackslash{\texttt{\textbackslash nabla} \textbackslash{\texttt{\textbackslash ^2}}}) can be used instead of \textbackslash{\texttt{\textbackslash bigtriangleup}}.

The character Menu Separator from the menu Insert \textbackslash{\texttt{\textbackslash Special Character}} is the operator \textbackslash{\texttt{\textbackslash triangleright}}.

10.5. Self-defined Operators

With the help of the command \textbackslash{\texttt{\textbackslash DeclareMathOperator}} custom operators can be defined in the L\textbackslash{\texttt{\textbackslash A}TEX-preamble. Its command scheme is:

\[ \text{\texttt{\textbackslash DeclareMathOperator\{new command\}\{display\}}} \]

Display can be characters or symbols that define how the operator looks in the output. To define a big operator a * is set behind the command. All self-defined big operators can have limits as described in sec. 10.2.
For example the \LaTeX-preamble line
\begin{verbatim}
\DeclareMathOperator*{\Lozenge}{\blacklozenge}
\end{verbatim}
defines the command \Lozenge, that inserts a big operator consisting of the lozenge symbol from sec. 13.2:
\begin{equation}
\mathop{\infty}\limits_{n=1}
\end{equation}
The command for this formula is: \Lozenge^\infty\rightarrow_{n=1}

When self-defined operators are not used several times in the document, they can also be defined with the commands \texttt{\textbackslash mathop} and \texttt{\textbackslash mathbin}, which have the following scheme:
\begin{verbatim}
\mathop{\text{display}} and \mathbin{\text{display}}
\end{verbatim}
\texttt{\textbackslash mathop} defines big operators, \texttt{\textbackslash mathbin} binary operators.
\texttt{\textbackslash mathop} can e.g. be used to use one limit for several operators:
\begin{equation}
\sum_i^N \sum_{j=1}^{i,j=1}
\end{equation}
The command for the formula above is:
\begin{verbatim}
\mathop{\text{\sum negmedspace}\text{\sum}}\rightarrow_{N\|i,j=1}
\end{verbatim}

11. Fonts

11.1. Font Styles

Latin letters in formulas can be set in one of the following font styles:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>\mathbb_ABC</td>
<td>ABC</td>
<td>-</td>
</tr>
<tr>
<td>\mathbf_AbC</td>
<td>AbC</td>
<td>Ctrl+Alt+B</td>
</tr>
<tr>
<td>\texttt{\textbackslash boldsymbol}_AbC</td>
<td>AbC</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>\mathcal_ABC</td>
<td>ABC</td>
<td>-</td>
</tr>
<tr>
<td>\mathfrak_AbC</td>
<td>AbC</td>
<td>-</td>
</tr>
</tbody>
</table>
Note: The styles \textbf{mathbb}, \textit{mathcal} and \textsc{mathscr} can only be used for big letters.

Predefined is the style \texttt{mathnormal}.  
The style commands work also for letters in mathematical constructs:

\[
\mathfrak{A} = \mathfrak{b} \mathfrak{c}
\]

Characters in mathematical text don’t appear in a math font style but in the text font style \texttt{textrm}. That their style can’t be set correctly via the text style dialog is a bug in LyX.\footnote{LyX-bug \#4629}

Instead of the style commands the dialog \texttt{Edit\textgreater Math\textgreater Text Style} or the toolbar button \texttt{\textcircled{A}} can be used.

11.2. Bold Formulas

To make a complete formula bold, the command \texttt{mathbf} from the previous subsection cannot be used, because it doesn’t work for small Greek letters. Furthermore it prints Latin letters always upright, like in the following equation:

\[
\int_n^2 f(\theta) = \Gamma \quad \text{equation with \texttt{mathbf}}
\]

To display the formula correctly, the command \texttt{boldsymbol} is used:

\[
\int_n^2 f(\theta) = \Gamma \quad \text{equation with \texttt{boldsymbol}}
\]

It is also possible to set the formula in a \texttt{boldmath environment}. This environment is created by inserting the command \texttt{boldmath} in \texttt{TeX} mode. To end the environment, the command \texttt{unboldmath} is inserted in \texttt{TeX} mode.

\[
\int_n^2 f(\theta) = \Gamma \quad \text{equation in a boldmath environment}
\]
11.3. Colored Formulas

Formulas can be colored like normal text: Highlight a formula or a formula part and use the Text Style dialog. Here is a formula in magenta:

\[ \int A \, dx = \frac{\sqrt{B}}{\ln \left( \frac{1}{3} \right)} \]

You can also define your own colors as described in sec. 9.3. They can be used with the \textcolor T\eX code command in the scheme

\textcolor{color}{characters or formula}

The following example was colored completely dark green and partly red:

\[ \int A \, dx = \frac{\sqrt{B}}{\ln \left( \frac{1}{3} \right)} \]

Due to a bug in \LaTeX only complete formulas can be colored with self-defined colors.\textsuperscript{25}

11.4. Font Sizes

For characters in formulas there are, analog to characters in text, the following size commands:

\texttt{\Huge, \huge, \LARGE, \Large, \large, \normalsize, \small, \footnotesize, \scriptsize} and \texttt{\tiny}

The size produced by the commands depends on the document font size, which corresponds to the command \texttt{\normalsize}. The other commands produce smaller or larger sizes than \texttt{\normalsize}. The font size can however not exceed a certain value. Is for example the document font size 12 pt, the command \texttt{\Huge} switches to the same size as \texttt{\huge}.

A size command is inserted in \TeX mode before the formula and sets the size for all following formula and text characters. To switch back to the initial size, the command \texttt{\normalsize} is inserted behind the formula in \TeX mode.

Within a formula the size can be changed using the following size commands or the toolbar button \( \Sigma \).

\textsuperscript{25}\LaTeX-bug \#5269

34
After entering these commands, a blue box appears in which the formula parts are inserted.

There is a further method to change the font size, that though only works for symbols or letters in mathematical text. To use it, one of the above text size commands is inserted in mathematical text. All following characters until the end of the mathematical text or until another size command will have the selected size. Two examples:

\begin{equation}
A = \frac{B}{C} \cdot \maltese
\end{equation}

Before both formulas the command \texttt{\huge} was inserted. The command for the second formula is:
\texttt{\maltese A Alt+M M \Large \maltese \textit A → → Alt+M M \tiny \maltese \textit A}

If a symbol cannot be displayed in different sizes, it will always be displayed in the default size.

12. Greek Letters

Greek letters can also be inserted via the toolbar button $\alpha$. All international typesetting norms purport that Greek letters in math have to be typeset italic/slanted. In some languages, like French or Russian, they are nevertheless sometimes typeset upright.
12.1. Small Letters

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\alpha</td>
<td>α</td>
</tr>
<tr>
<td>\beta</td>
<td>β</td>
</tr>
<tr>
<td>\gamma</td>
<td>γ</td>
</tr>
<tr>
<td>\delta</td>
<td>δ</td>
</tr>
<tr>
<td>\epsilon</td>
<td>ϵ</td>
</tr>
<tr>
<td>\varepsilon</td>
<td>ε</td>
</tr>
<tr>
<td>\zeta</td>
<td>ζ</td>
</tr>
<tr>
<td>\eta</td>
<td>η</td>
</tr>
<tr>
<td>\theta</td>
<td>θ</td>
</tr>
<tr>
<td>\vartheta</td>
<td>ϑ</td>
</tr>
</tbody>
</table>

How to create special upright Greek letters is explained in sec. 24.9.

12.2. Big Letters

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\Gamma</td>
<td>Γ</td>
</tr>
<tr>
<td>\Delta</td>
<td>Δ</td>
</tr>
<tr>
<td>\Theta</td>
<td>Θ</td>
</tr>
<tr>
<td>\Lambda</td>
<td>Λ</td>
</tr>
<tr>
<td>\Xi</td>
<td>Ξ</td>
</tr>
<tr>
<td>\Pi</td>
<td>Π</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\Sigma</td>
<td>Σ</td>
</tr>
<tr>
<td>\Upsilon</td>
<td>Υ</td>
</tr>
<tr>
<td>\Phi</td>
<td>Φ</td>
</tr>
<tr>
<td>\Psi</td>
<td>Ψ</td>
</tr>
<tr>
<td>\Omega</td>
<td>Ω</td>
</tr>
</tbody>
</table>

That the big Greek letters appear upright is caused by a design bug when TeX was developed. To get correct italic big letters, begin every command with \textit{var}.

For example the command \texttt{\varGamma} produces Γ. Another way is to load the package \texttt{fixmath}\footnote{fixmath is part of the \LaTeX-package \texttt{was.}} with the \LaTeX-preamble line

\texttt{\usepackage{fixmath}}

Then all big Greek letters in a document will automatically be typeset italic.

12.3. Bold Letters

Greek letters cannot be set with different font styles like Latin letters. They can only be made bold with the command \texttt{\boldsymbol}.

\texttt{\varGamma}
13. Symbols

Many of the symbols listed in this section can also be inserted via the toolbar buttons \( \nabla \) and \( F \).

### 13.1. Mathematical Symbols

<table>
<thead>
<tr>
<th>Command</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>\neg</td>
<td>( \neg )</td>
</tr>
<tr>
<td>\Im</td>
<td>( \Im )</td>
</tr>
<tr>
<td>\Re</td>
<td>( \Re )</td>
</tr>
<tr>
<td>\aleph</td>
<td>( \aleph )</td>
</tr>
<tr>
<td>\partial</td>
<td>( \partial )</td>
</tr>
<tr>
<td>\infty</td>
<td>( \infty )</td>
</tr>
<tr>
<td>\wp</td>
<td>( \wp )</td>
</tr>
<tr>
<td>\imath</td>
<td>( \imath )</td>
</tr>
<tr>
<td>\jmath</td>
<td>( \jmath )</td>
</tr>
<tr>
<td>\forall</td>
<td>( \forall )</td>
</tr>
<tr>
<td>\exists</td>
<td>( \exists )</td>
</tr>
<tr>
<td>\nexists</td>
<td>( \nexists )</td>
</tr>
<tr>
<td>\emptyset</td>
<td>( \emptyset )</td>
</tr>
<tr>
<td>\varnothing</td>
<td>( \varnothing )</td>
</tr>
<tr>
<td>\dag</td>
<td>( \dag )</td>
</tr>
<tr>
<td>\ddag</td>
<td>( \ddag )</td>
</tr>
<tr>
<td>\complement</td>
<td>( \complement )</td>
</tr>
<tr>
<td>\Bbbk</td>
<td>( \Bbbk )</td>
</tr>
<tr>
<td>\prime</td>
<td>( \prime )</td>
</tr>
<tr>
<td>\backprime</td>
<td>( \backprime )</td>
</tr>
<tr>
<td>\mho</td>
<td>( \mho )</td>
</tr>
<tr>
<td>\triangle</td>
<td>( \triangle )</td>
</tr>
<tr>
<td>\angle</td>
<td>( \angle )</td>
</tr>
<tr>
<td>\dag</td>
<td>( \dag )</td>
</tr>
<tr>
<td>\ddag</td>
<td>( \ddag )</td>
</tr>
<tr>
<td>\complement</td>
<td>( \complement )</td>
</tr>
<tr>
<td>\Bbbk</td>
<td>( \Bbbk )</td>
</tr>
<tr>
<td>\prime</td>
<td>( \prime )</td>
</tr>
<tr>
<td>\backprime</td>
<td>( \backprime )</td>
</tr>
<tr>
<td>\mho</td>
<td>( \mho )</td>
</tr>
<tr>
<td>\triangle</td>
<td>( \triangle )</td>
</tr>
<tr>
<td>\angle</td>
<td>( \angle )</td>
</tr>
</tbody>
</table>

### 13.2. Miscellaneous Symbols

<table>
<thead>
<tr>
<th>Command</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>\flat</td>
<td>( \flat )</td>
</tr>
<tr>
<td>\natural</td>
<td>( \natural )</td>
</tr>
<tr>
<td>\sharp</td>
<td>( \sharp )</td>
</tr>
<tr>
<td>\surd</td>
<td>( \surd )</td>
</tr>
<tr>
<td>\checkmark</td>
<td>( \checkmark )</td>
</tr>
<tr>
<td>\yen</td>
<td>( \yen )</td>
</tr>
<tr>
<td>\pounds</td>
<td>( \pounds )</td>
</tr>
<tr>
<td>$</td>
<td>( $ )</td>
</tr>
<tr>
<td>§</td>
<td>( $ )</td>
</tr>
<tr>
<td>\hbar</td>
<td>( \hbar )</td>
</tr>
<tr>
<td>\hslash</td>
<td>( \hslash )</td>
</tr>
<tr>
<td>\clubsuit</td>
<td>( \clubsuit )</td>
</tr>
<tr>
<td>\spadesuit</td>
<td>( \spadesuit )</td>
</tr>
<tr>
<td>\bigstar</td>
<td>( \bigstar )</td>
</tr>
<tr>
<td>\blacklozenge</td>
<td>( \blacklozenge )</td>
</tr>
<tr>
<td>\heartsuit</td>
<td>( \heartsuit )</td>
</tr>
<tr>
<td>\Diamond</td>
<td>( \Diamond )</td>
</tr>
<tr>
<td>\heartsuit</td>
<td>( \heartsuit )</td>
</tr>
<tr>
<td>\copyright</td>
<td>( \copyright )</td>
</tr>
<tr>
<td>\circledR</td>
<td>( \circledR )</td>
</tr>
<tr>
<td>\maltese</td>
<td>( \maltese )</td>
</tr>
<tr>
<td>\diagup</td>
<td>( \diagup )</td>
</tr>
<tr>
<td>\diagdown</td>
<td>( \diagdown )</td>
</tr>
</tbody>
</table>

Some symbols can be displayed in different sizes, see sec. 11.4.

---

27A list with all symbols of most of the \LaTeX\-packages can be found in [4].
13.3. The Euro-Symbol €

To use the Euro symbol in formulas, the \LaTeX-package `eurosym` must be installed and loaded with the \LaTeX-preamble line

\texttt{\usepackage[gennarrow]{eurosym}}

The Euro symbol can now be inserted with the command \texttt{\euro}.

The Euro symbol can directly be inserted with the € key in mathematical text, without having `eurosym` installed. When `eurosym` is installed, \texttt{\euro} can also be inserted in \TeX mode. The official currency symbol can then be inserted with the command \texttt{\officialeuro}, that is only available in \TeX mode.

An overview about the different Euro symbols:

<table>
<thead>
<tr>
<th>Command</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>formula</td>
<td>\texttt{\euro}</td>
</tr>
<tr>
<td>mathematical text</td>
<td>€</td>
</tr>
<tr>
<td>\TeX mode</td>
<td>\texttt{\officialeuro}</td>
</tr>
</tbody>
</table>

14. Relations

All following relations can also be inserted via the toolbar button $\leq$.

<table>
<thead>
<tr>
<th>Command</th>
<th>Relation</th>
<th>Command</th>
<th>Relation</th>
<th>Command</th>
<th>Relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>$&lt;$</td>
<td>$&lt;$</td>
<td>$=$</td>
<td>$=$</td>
<td>$&gt;$</td>
<td>$&gt;$</td>
</tr>
<tr>
<td>\texttt{\le}</td>
<td>$\land$</td>
<td>\texttt{\not=}</td>
<td>$\neq$</td>
<td>\texttt{\ge}</td>
<td>$\lor$</td>
</tr>
<tr>
<td>\texttt{\ll}</td>
<td>$\lor$</td>
<td>\texttt{\equiv}</td>
<td>$\equiv$</td>
<td>\texttt{\gg}</td>
<td>$\lnot$</td>
</tr>
<tr>
<td>\texttt{\prec}</td>
<td>$\times$</td>
<td>\texttt{\sim}</td>
<td>$\approx$</td>
<td>\texttt{\succ}</td>
<td>$\models$</td>
</tr>
<tr>
<td>\texttt{\preceq}</td>
<td>$\cup$</td>
<td>\texttt{\simeq}</td>
<td>$\approx$</td>
<td>\texttt{\supset}</td>
<td>$\subseteq$</td>
</tr>
<tr>
<td>\texttt{\subset}</td>
<td>$\cap$</td>
<td>\texttt{\simeq}</td>
<td>$\approx$</td>
<td>\texttt{\supseteq}</td>
<td>$\supseteq$</td>
</tr>
<tr>
<td>\texttt{\subsetsq}</td>
<td>$\in$</td>
<td>\texttt{\bowtie}</td>
<td>$\bowtie$</td>
<td>\texttt{\ni}</td>
<td>$\ni$</td>
</tr>
<tr>
<td>\texttt{\vdash}</td>
<td>$\top$</td>
<td>\texttt{\perp}</td>
<td>$\bot$</td>
<td>\texttt{\dashv}</td>
<td>$\top$</td>
</tr>
<tr>
<td>\texttt{\smile}</td>
<td>$\hom$</td>
<td>\texttt{\propto}</td>
<td>$\propto$</td>
<td>\texttt{\frown}</td>
<td>$\lhd$</td>
</tr>
<tr>
<td>\texttt{\lhd}</td>
<td>$\nmid$</td>
<td>\texttt{\unlhd}</td>
<td>$\unlhd$</td>
<td>\texttt{\unrhd}</td>
<td>$\unrhd$</td>
</tr>
<tr>
<td>\texttt{\gtrless}</td>
<td>$\nmid$</td>
<td>\texttt{\circeq}</td>
<td>$\circeq$</td>
<td>\texttt{\lessgtr}</td>
<td>$\lessgtr$</td>
</tr>
<tr>
<td>\texttt{\mid}</td>
<td>$\models$</td>
<td>\texttt{\models}</td>
<td>$\models$</td>
<td>\texttt{\parallel}</td>
<td>$\parallel$</td>
</tr>
<tr>
<td>\texttt{\nmid}</td>
<td>$\nmid$</td>
<td>\texttt{\widehat=}</td>
<td>$\widehat{=}</td>
<td>\texttt{\nparallel}</td>
<td>$\nparallel$</td>
</tr>
</tbody>
</table>
The characters \textbackslash lhd and \textbackslash rhd are bigger than the equal looking operators \textbackslash triangleleft and \textbackslash triangleright, respectively.

\LaTeX{} supports also many special relations. Use the toolbar button \simeq to see a list of these relations.

Relations are, in contrary to symbols, always surrounded by space.

Relations with labels can be created with the command \textbackslash stackrel:

\begin{center}
\begin{tabular}{|c|c|}
\hline
Command & Result \\
\hline
A(r)\textbackslash stackrel_r\to\textbackslash infty\approx B & A(r) \rightarrow \infty \approx B \\
\hline
\end{tabular}
\end{center}

15. Functions

15.1. Predefined Functions

In general, variables are set italic in mathematical expressions, but not function names, because \textit{sin} could be misunderstood as \textit{s} \cdot \textit{i} \cdot \textit{n}. Therefore there are predefined functions which are additionally a bit separated from prefactors. They are inserted as commands starting with a backslash separated from prefactors. They are inserted as commands starting with a backslash before their name.

\begin{center}
\begin{tabular}{|c|c|}
\hline
Command & Result \\
\hline
Asin(x)+B & Asin(x) + B \\
\hline
\end{tabular}
\end{center}

The following functions are predefined:

\begin{center}
\begin{tabular}{|c|c|}
\hline
Command & Command \\
\hline
\sin & \sinh \\
\cos & \cosh \\
\tan & \tanh \\
\cot & \coth \\
\sec & \csc \\
\ln & \exp \\
\lg & \log \\
\hline
\end{tabular}
\end{center}

They can also be inserted with the math toolbar button \textit{exp}. 

\textit{tan}. 

39
15.2. Self-defined Functions

To use a function that is not predefined, like for example the sign function \( \text{sgn}(x) \), there are two possibilities:

- Define the function by inserting the following line to the \LaTeX\-preamble\(^{28}\):
  \[
  \text{\texttt{\textbackslash DeclareMathOperator\{\texttt{\textbackslash sgn}\}\{\texttt{\textbackslash sgn}\}}}
  \]
  Now the new defined function can be called with the command \( \texttt{\textbackslash sgn} \).

- Write the formula as usual, mark the formula name, in our example the letters \( sgn \), and change it to mathematical text. Finally, a space is inserted between prefactor and function.

The result is the same with both methods as with a predefined function\(^{29}\):

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>( A\texttt{\textbackslash sgn}(x)+B )</td>
<td>( A\text{sgn}(x)+B )</td>
</tr>
<tr>
<td>( A,\texttt{\textbackslash sgn}( (x))+B )</td>
<td>( A\text{sgn}(x)+B )</td>
</tr>
<tr>
<td>(Alt+M M)</td>
<td></td>
</tr>
</tbody>
</table>

The first method is more suitable when the self-defined function should be used several times.

15.3. Limits

For limits, in addition to the commands \texttt{\textbackslash lim}, \texttt{\textbackslash liminf} and \texttt{\textbackslash limsup} the following functions are defined:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{\textbackslash varliminf}</td>
<td>( \text{\texttt{\textbackslash lim}} )</td>
</tr>
<tr>
<td>\texttt{\textbackslash varlimsup}</td>
<td>( \text{\texttt{\textbackslash lim}} )</td>
</tr>
<tr>
<td>\texttt{\textbackslash varprojlim}</td>
<td>( \text{\texttt{\textbackslash lim}} )</td>
</tr>
<tr>
<td>\texttt{\textbackslash varinjlim}</td>
<td>( \text{\texttt{\textbackslash lim}} )</td>
</tr>
</tbody>
</table>

The limit is created by inserting a subscript. It is set right beside the function in an inline formula:

\(^{28}\)For more about \texttt{\textbackslash DeclareMathOperator} see sec.10.5.

\(^{29}\)In \LaTeX\ self-defined functions are displayed red, predefined ones black.
In a displayed formula the limit is set below the formula, as usual:

\[ \lim_{x \to A} x = B \]

How to adjust the typesetting of the limits see sec. 10.2.

15.4. Modulo-Functions

The modulo-function is special, because it exists in four variants. The variants in a displayed formula are:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>a \mod_b</td>
<td>a \mod b</td>
</tr>
<tr>
<td>a \pmod_b</td>
<td>a (mod b)</td>
</tr>
<tr>
<td>a \bmod_b</td>
<td>a \mod b</td>
</tr>
<tr>
<td>a \pod_b</td>
<td>a (b)</td>
</tr>
</tbody>
</table>

In an inline formula less space is set before the function names for all variants. By default the modulo-functions take only the first following character into account. To use more than one character, one has to put them into \TeX\ braces:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>a \pod{bcd</td>
<td>a (b)cd</td>
</tr>
<tr>
<td>a \pod{bc \rightarrow d</td>
<td>a (bc)d</td>
</tr>
</tbody>
</table>

16. Special Characters

The characters ^ and _ would normally create a superscript and subscript, respectively. To get these characters you have to insert them with a leading \: 

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>^</td>
</tr>
<tr>
<td>_</td>
<td>_</td>
</tr>
</tbody>
</table>
16.1. Special Characters in Mathematical Text

The following commands can only be used in mathematical text or in \TeX\ mode:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\oe</td>
<td>œ</td>
</tr>
<tr>
<td>\OE</td>
<td>ÙE</td>
</tr>
<tr>
<td>\ae</td>
<td>æ</td>
</tr>
<tr>
<td>\AE</td>
<td>Æ</td>
</tr>
<tr>
<td>\aa</td>
<td>å</td>
</tr>
<tr>
<td>\AA</td>
<td>Å</td>
</tr>
<tr>
<td>\i</td>
<td>ı</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\o</td>
<td>ø</td>
</tr>
<tr>
<td>\O</td>
<td>Ø</td>
</tr>
<tr>
<td>\l</td>
<td>ł</td>
</tr>
<tr>
<td>\L</td>
<td>Ł</td>
</tr>
<tr>
<td>!`/uni2423</td>
<td>¡</td>
</tr>
<tr>
<td>?`/uni2423</td>
<td>¿</td>
</tr>
<tr>
<td>\j</td>
<td>j</td>
</tr>
</tbody>
</table>

The characters Å and Ø can also be inserted via the math toolbar button \( F \).

An exception are the commands !' and ?', because they can be inserted in \LaTeX\ directly to text.

16.2. Accents in Text

With the following commands all letters can be accented. The commands must be inserted in \TeX\ mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;e</td>
<td>ë</td>
</tr>
<tr>
<td>`e</td>
<td>è</td>
</tr>
<tr>
<td>^/uni2423e</td>
<td>ê</td>
</tr>
<tr>
<td>=e</td>
<td>¯e</td>
</tr>
<tr>
<td>u/uni2423e</td>
<td>˘e</td>
</tr>
</tbody>
</table>
| t/uni2423ee | ´

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>H/uni2423e</td>
<td>˝e</td>
</tr>
<tr>
<td>'e</td>
<td>é</td>
</tr>
<tr>
<td>~e</td>
<td>˜e</td>
</tr>
<tr>
<td>.e</td>
<td>˙e</td>
</tr>
<tr>
<td>\v/uni2423e</td>
<td>ě</td>
</tr>
<tr>
<td>\d/uni2423e</td>
<td>e .</td>
</tr>
<tr>
<td>\c/uni2423e</td>
<td>¯e</td>
</tr>
</tbody>
</table>

With the command \( \backslash t \) also two different characters can be accented. The command \( \backslash t_{\backslash sz} \) creates: ść

The accents ‘ , ’ and \( ^\sim \) can in combination with vowels directly be inserted with the keyboard without using \TeX\ mode. The same applies for the tilde\(^{30} \) in combination with \( a , n , \) or \( o . \)

The commands \( \backslash b , \backslash c , \backslash d , \backslash H , \backslash t , \backslash u , \backslash v \) and accents that are inserted directly with the keyboard are also available in mathematical text. For the other accents there are special math commands to be used in formulas, see sec. 7.1.

\(^{30}\)This only applies for keyboards where the tilde is defined as accent.
Furthermore, with the command \textcircled{} all numbers and letters can be set into a circle, quasi accented with a circle, similar to the copyright symbol.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textcircled{w}</td>
<td>⊙</td>
</tr>
<tr>
<td>\Large \textcircled{\normalsize\protect\raisebox{-1.5pt}{W}}</td>
<td>W</td>
</tr>
</tbody>
</table>

One has to take care that the character fits in the circle. \Large\textcircled{} specifies thereby the size of the circle. With the help of \raisebox\textcircled{} the character can be centered.

16.3. Old-style Figures

Old-style figures (also known as old-style numerals) are created with the command \oldstylenums. The command can be used in formulas and in TeX mode. The command scheme is:

\oldstylenums{number}

The command \oldstylenums{0123456789} produces: 0123456789

17. Formula Styles

- There are two different alignment styles:
  - **Centered** is the predefined standard
  - **Indented** for this the option fleqn must be inserted in the menu Document > Settings under Document Class

  When Indented is used, the indentation can be adjusted with the length \mathindent. Should the distance be 15mm, the following command line is inserted in the \LaTeX-preamble

  \setlength{\mathindent}{15mm}

  When no length is specified, a predefined value will be used. The value depends on the used document class.

- And two different numbering styles:
  - **Right** is the predefined standard
  - **Left** for this the option leqno must be inserted in the menu Document > Settings under Document Class

\[^{31}\text{see sec. 11.4}\]
\[^{32}\text{see sec. 9.2}\]
fleqn and leqno can also be used together. In this case both options are inserted, separated by a comma.

The chosen styles are used for all displayed formulas of the document. When both, centered and indented formulas should be created in a document, the style Centered is used. The indented formulas are then set in a flalign environment, see sec.18.2.3.

18. Multiline Formulas

18.1. General

In \LaTeXX multiline formulas are created by pressing Ctrl+Return inside a formula. This creates either an align environment that is described in sec.18.2.1 or, when automatically loading the package AMS math is disabled in the document settings, an \texttt{amsmath} environment that is described in sec.18.3. The align environment is recommended because it provides in any case a typographically correct output.

There are other multiline formula environments that can be created via the menu Insert\rightarrow Math. These environments are described in the following sections.

In all multiline formula environments a new line is created by pressing Ctrl+Return. To add or delete lines, the math toolbar buttons \[\] or \[\], respectively, or the menu Edit\rightarrow Rows & Columns can be used.

18.1.1. Line Separation

There is sometimes not enough space in multiline formulas between the lines:

\[
B^2(B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2) + 4x_0^2x^2 + 4x_0xD = -4x^2B^2 + 4x_0xB^2
\]

\[
4x^2(B^2 + x_0^2) + 4x_0x(D - B^2) + B^2(B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2) = 0
\]

In \LaTeXX additional line space is specified as optional argument of the new line command. This is not yet possible in \LyX, therefore the whole formula must be inserted in \TeXX mode. To add in our example space, the command \[\,[3\text{mm}]\] is inserted at the end of the first line. One gets:

\[
B^2(B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2) + 4x_0^2x^2 + 4x_0xD = -4x^2B^2 + 4x_0xB^2
\]

\[
4x^2(B^2 + x_0^2) + 4x_0x(D - B^2) + B^2(B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2) = 0
\]

To set the line separation for all lines in a formula, the length \[\jot\] is changed. The definition is: line separation = 6 pt + \jot. Predefined for \jot is the value 3 pt. To create 3 mm additional line separation as in the previous example, the command

\[3\text{mm}\]\see LyX-bug #1505
\setlength{\jot}{3\text{mm}+3\text{pt}}

is inserted in \TeX mode before the formula. This requires that the \LaTeX-package
\texttt{calc}\textsuperscript{34} was loaded in \LaTeX-preamble with the line
\begin{verbatim}
\usepackage{calc}
\end{verbatim}

One gets:
\[
B^2 (B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2) + 4x_0^2 x^2 + 4x_0 x D = -4x^2 B^2 + 4x_0 x B^2 \\
4x^2 (B^2 + x_0^2) + 4x_0 x (D - B^2) + B^2 (B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2) = 0
\]

To get back to the predefined distance, \texttt{\jot} is set to the value 3 pt.

\section*{18.1.2. Column Separation}

Multiline formulas form a matrix. A formula in the \texttt{eqnarray} environment is for
example a matrix with three columns. By changing the column separation in this
environment, the space beside the relation sign can be changed.

The column separation is specified with the length \texttt{\arraycolsep} according to:
\begin{verbatim}
column separation = 2 \texttt{\arraycolsep}
\end{verbatim}

Thus, the command
\begin{verbatim}
\setlength{\arraycolsep}{1cm}
\end{verbatim}

inserted in \TeX mode, sets for all following formulas a column separation of 2 cm. To
get back to the predefined distance, \texttt{\arraycolsep} is set to 5 pt.

A formula with 2 cm column separation:
\[
\begin{array}{c}
A \\
C
\end{array} = \begin{array}{c}
B \\
A
\end{array}
\]

A formula with the predefined column separation for matrices of 10 pt:
\[
\begin{array}{c}
A \\
C
\end{array} = \begin{array}{c}
B \\
A
\end{array}
\]

\textsuperscript{34}\texttt{calc} is part of every \LaTeX standard installation.
18.1.3. Long Formulas

Long formulas can be typeset using these methods:

- When one side of the equation is much shorter than the line width, this one is chosen for the left side and the right side is typeset over two lines:

\[
H = W_{SB} + W_{mv} + W_D - \frac{\hbar^2}{2m_0} \Delta - \frac{\hbar^2}{2m_1} \Delta_1 - \frac{\hbar^2}{2m_2} \Delta_2 - \frac{e^2}{4\pi\varepsilon_0 |r - R_1|} - \frac{e^2}{4\pi\varepsilon_0 |r - R_2|} + \frac{e^2}{4\pi\varepsilon_0 |R_1 - R_2|} \tag{7}
\]

The minus sign at the beginning of the second line does normally not appear as an operator because it is the first character of the line. Thus it would not be surrounded by space and could not be distinguished from the fraction bar. To avoid this, 3 pt space was inserted behind the minus sign with the command \hspace.\footnote{for more about \hspace see sec. 8.2}

- When both sides of the equation are too long, the command \lefteqn is used.

It is inserted in the first column of the first line and causes all further insertions to overwrite the following columns:

\[
4x^2 \left( B^2 + x_0^2 \right) + 4x_0x \left( D - B^2 \right) + B^2 \left( 2r_g^2 + 2x_0^2 - 2r_k^2 \right) + D^2 - B^2 - 2B \sqrt{r_g^2 - x^2 + 2x_0x - x_0^2} + r_g^2 - x^2 + 2x_0x - x_0^2
\]

\[
= B^2 + 2 \left( r_g^2 + 2x_0x - x_0^2 - r_k^2 \right) + \frac{\left( r_g^2 + 2x_0x - x_0^2 - r_k^2 \right)^2}{B^2} \tag{8}
\]

After the insertion of \lefteqn, the cursor is in a purple box that is a bit shifted to the left from the blue one. In this the formula is inserted. The content of the further lines is inserted to the second or another formula column. The greater the column number where it was inserted, the larger the indentation.

Note the following when using \lefteqn:

- The formula doesn’t use the full page width. When e.g. the term \(-B^2\) is added to the first line in the above example, it would have been outside the page margin. To better use the width, negative space can be inserted at the beginning of the first line.

- Due to a bug in LyX the cursor cannot be set with the mouse into the first line.\footnote{LyX-bug #1429} One can only set the cursor at the beginning of the line and move it with the arrow keys.

- Other methods to set long formulas are offered by the environments described in sec. 18.5 and sec. 18.6.
18.1.4. Multiline Fractions

There are cases where the denominator and/or the numerator of a fraction is so long that the fraction does not fit into one line. It is then necessary to add a line break within the fraction. This can be done using the command \splitfrac. To activate it, set in the document settings under Math Options for the package mathtools the option Load always. \splitfrac has the scheme

\splitfrac{first line}{second line}

and is used as denominator and/or numerator:

\[ a = \frac{xy + xy + xy + xy}{z} + \frac{xy + xy}{z} \neq \frac{xy + xy + xy + xy}{z} \]

The command for the first numerator above is:

\splitfrac{xy+xy+xy+xy}{z} {+wy+wy+wy+wy}

18.1.5. Multiline Brackets

For brackets spanning multiple lines the following problem occurs:

\[ A = \sin(x) \left[ \prod_{R=1}^{\infty} \frac{1}{R} + \cdots + B - D \right] \]

The closing bracket is smaller than the opening bracket because brackets with variable size may not span multiple lines.

To set the bracket size for the second line correctly, the first line is ended with \right. and the second line with \left.\text{\phantom{\prod}}\text{\phantom{\infty\downarrow}_{R=1}}\right\} for more about \left and \right see sec. 5.1.2.

The result is this:

\[ A = \sin(x) \left[ \prod_{R=1}^{\infty} \frac{1}{R} + \cdots + B - D \right] \]
18.2. Align Environments

Align environments can be used for every kind of multiline formulas. They are especially useful to set several formulas side by side.

Align environments consist of columns. The odd columns are right aligned, the even ones left aligned. Every line in an Align environment can be numbered.

Align environments are created via the menu Insert Math. With the menu Edit Math Change Formula Type already existing formulas can be converted to Align environments.

To add or delete columns, the math toolbar buttons or , respectively, or the menu Edit Rows & Columns can be used.

18.2.1. Standard align Environment

This Align environment is created by pressing Ctrl+Return in a formula or by the menu Insert Math AMS align Environment.

An example for two formulas set side by side, that are created with a four column align environment:

\[
\begin{align*}
A &= \sin(B) & C &= D \\
C \neq A & & B \neq D
\end{align*}
\]

As it can be seen, the formulas in this environment are placed so as if there would be a \texttt{\hfill} before the first and after every even column. When the formula style Indented is used, the formula is set without the \texttt{\hfill} before the first column.

18.2.2. Alignat Environment

The alignat environment has no predefined column separation. It can be inserted manually with the spaces that are described sec. 8.

The above example in the alignat environment where 1 cm space was inserted at the beginning of the second formula:

\[
\begin{align*}
A &= \sin(B) & C &= D \\
C \neq A & & B \neq D
\end{align*}
\]

Because the column separation can be set separately for every column, this environment is especially suitable to set three and more formulas side by side.

more about \texttt{\hfill} see sec. 8.2
formula styles see sec. 17
18.2.3. Flalign Environment

In this environment the first two columns are always set as much as possible to the left and the last two ones to the right. An example:

\[
\begin{align*}
A &= 1 & B &= 2 & C &= 3 \\
X &= -1 & Y &= -2 & Z &= 4 \\
\end{align*}
\]

By creating a flalign environment with an odd number of columns where an empty \TeX{} brace is inserted to the last column, several formulas in a document can be set to the left, although the formula style \texttt{Centered} is used. As example the indented formula (5):

\[
\int_V X \, dV = U
\]  

The first two columns contain the formula. To indent it as with the formula style \texttt{Indented}, 30 pt space was inserted at the beginning of the first column.

18.3. Eqnarray Environment

When this environment has been created, three blue boxes appear. The content of the first box is right aligned, the content of the last one left aligned. The content of the middle box appears centered and a bit smaller, because it is designed to insert there only relation characters.

\[
\begin{array}{ccc}
ABC & ABC & ABC \\
D & D & D \\
AB & AB & AB \\
A &= A
\end{array}
\]

18.4. Gather Environment

This environment consists of only one centered column. Every line can be numbered.

\[
\begin{align*}
A &= 1 \\
X &= -1 \\
\end{align*}
\]

18.5. Multline Environment

The multline environment consists, like the gather environment, of only one column. But the first line is left aligned, the last one right aligned. All other lines are centered.
Therefore this environment is suitable for long formulas. As example formula (8) in the multiline environment:

\[ 4x^2 \left( B^2 + x_0^2 \right) + 4x_0x \left( D - B^2 \right) + B^2 \left( B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2 \right) + D^2 \]

\[ - B^2 - 2B \sqrt{r_g^2 - x^2 + 2x_0x - x_0^2 + r_g^2 - x^2 + 2x_0x - x_0^2} \]

\[ = B^2 + 2 \left( r_g^2 + 2x_0x - x_0^2 - r_k^2 \right) + \frac{\left( r_g^2 + 2x_0x - x_0^2 - r_k^2 \right)^2}{B^2} \] (12)

In the output only the last (first) line of a multline environment appears numbered when the document numbering is right (left)\(^{40}\).

With the commands `\shoveright` and `\shoveleft` a centered line can be right or left aligned, respectively. The commands are used as follows:

`\shoveright{line content}` and `\shoveleft{line content}`

The length `\multlinegap` specifies the distance of the first line from the left page margin. Predefined is the length 0 pt.

As example the above formula where the command

`\setlength{\multlinegap}{2cm}`

was inserted in \TeX{} mode before:

\[ 4x^2 \left( B^2 + x_0^2 \right) + 4x_0x \left( D - B^2 \right) + B^2 \left( B^2 - 2r_g^2 + 2x_0^2 - 2r_k^2 \right) + D^2 \]

\[ - B^2 - 2B \sqrt{r_g^2 - x^2 + 2x_0x - x_0^2 + r_g^2 - x^2 + 2x_0x - x_0^2} \]

\[ = B^2 + 2 \left( r_g^2 + 2x_0x - x_0^2 - r_k^2 \right) + \frac{\left( r_g^2 + 2x_0x - x_0^2 - r_k^2 \right)^2}{B^2} \] (13)

The second line was left aligned using `\shoveleft`.

### 18.6. Multiline Formula Parts

To display only parts of a formula with multiple lines, one of the following environments is used: `aligned`, `alignedat`, `gathered` or `split`. They can be inserted via the menu `Insert > Math` or by using the commands described in this section.

The first three have the same properties as the corresponding multiline formula environments, but it is possible to set further formula parts beside them. An example:

\[
\begin{align*}
\Delta x \Delta p & \geq \frac{\hbar}{2} \\
\Delta E \Delta t & \geq \frac{\hbar}{2}
\end{align*}
\]

Uncertainty relations

\(^{40}\)numbering styles see sec. 17
To get this formula, a displayed formula is created where the command \texttt{aligned} is inserted. A purple box appears around the blue formula box where now columns and lines can be added. Outside the multiline environment other formula parts can be set, like the brace.

The aligned environment is also suitable for long formulas whose lines are horizontally aligned. Using aligned in a displayed formula has the advantage that the formula number is vertically centered behind the lines. As example formula (7) in the aligned environment:

\[
H = W_{SB} + W_{mv} + W_D - \frac{\hbar^2}{2m_0} \Delta - \frac{\hbar^2}{2m_1} \Delta_1 - \frac{\hbar^2}{2m_2} \Delta_2 - \frac{e^2}{4\pi \varepsilon_0 |r - R_1|} \\
- \frac{e^2}{4\pi \varepsilon_0 |r - R_2|} + \frac{e^2}{4\pi \varepsilon_0 |R_1 - R_2|}
\]

(14)

To use the environments \texttt{alignedat}, \texttt{gathered}, or \texttt{split}, the command \texttt{alignedat}, \texttt{gathered}, or \texttt{split} are inserted, respectively. The split environment has the same properties as the aligned environment but it can only have two columns.

18.7. Text in multiline Formulas

In the Align environments, and the multiline and gather environment, text can be inserted that will appear in a separate line and doesn’t affect the column alignment. To do this, the command \texttt{\intertext} is used in the following scheme:

\texttt{\intertext\{text\}}

The text should not be longer than a line because it cannot be hyphenated. As \LaTeX\ doesn’t yet support \texttt{\intertext} directly, the text is written as mathematical text. \texttt{\intertext} must hereby be at the beginning of a line and appears in the output above this line. An example where the text was inserted at the beginning of the second line:

\[
I = a \sqrt{2} \int_0^{2\pi} \sqrt{1 + \cos(\phi)} \, d\phi
\]

(15)

integrand is symmetric to $\phi = \pi$, therefore

\[
= 2a \sqrt{2} \int_0^{\pi} \sqrt{1 + \cos(\phi)} \, d\phi
\]

(16)

\texttt{\intertext} always creates some vertical space between the text and the formula lines. To avoid this space, set in the document settings under \texttt{Math Options} for the package \texttt{mathtools} the option \texttt{Load always}. Then you can use the command \texttt{\shortintertext} instead of \texttt{\intertext}:
\[ I = a \sqrt{2} \int_0^{2\pi} \sqrt{1 + \cos(\phi)} \, d\phi \]  

(17)

Integrand is symmetric to \( \phi = \pi \), therefore

\[ = 2a \sqrt{2} \int_0^{\pi} \sqrt{1 + \cos(\phi)} \, d\phi \]  

(18)

19. Formula Numbering

19.1. General

Numbered formulas can be created with the menu Insert \( \triangleright \) Math \( \triangleright \) Numbered Formula (shortcut Ctrl+Alt N). Existing formulas can be numbered with the menu Edit \( \triangleright \) Math \( \triangleright \) Toggle Numbering (shortcut Alt+M N). The formula number is displayed in \texttt{LYX} behind the formula as a number sign in parentheses. The number sign is replaced in the output by the formula number.

When numbering is turned on in multiline formulas, all lines will be numbered. But the numbering can be controlled with the menu Edit \( \triangleright \) Math \( \triangleright \) Toggle Numbering of Line (shortcut Alt+M Shift+N) for every line.

Except for inline formulas, all formulas can be numbered with two different styles, see sec. 17.

19.2. Cross-References

All labeled formulas can be cross-referenced. A label is added by the menu Insert \( \triangleright \) Label or the toolbar button \( \equiv \). The cursor must hereby be inside a displayed formul.a. Alternatively you can right-click on the formula and choose Equation Label. A dialog pops up displaying the prefix eq: in a text field. The label is inserted there behind the prefix. The predefined prefix means “equation” and makes it easier to find labels in large documents because it marks it as formula label to divide it from e.g. section labels. To change a label, the menu Insert \( \triangleright \) Label is used again or you right-click on a formula and then on Equation Label.

The name of the label is displayed in \texttt{LYX} within two parentheses behind formula. A formula with a label is always numbered.

Cross-references are inserted via the menu Insert \( \triangleright \) Cross-Reference or with the toolbar button \( \equiv \). A formula cross-reference appears in the output as formula number. When in the cross-reference dialog window the format \( \langle \text{<reference>} \rangle \) is chosen, the cross-reference appears in the output as formula number in parentheses.

By right-clicking on a cross-reference in \texttt{LYX}, one jumps to the formula that is referenced.
Here are as examples cross-references to formulas of the following subsections:

The equations (something) and (20b) are equivalent. In (Z) big Latin letters are used for the numbering in contrary to (XXIV).

When the argument of \texttt{tag}\textsuperscript{41} contains a box like in sec. 9.4, the formula cannot be referenced.

\textbf{19.3. Subnumbering}

With the help of the commands \texttt{\begin{subequations}} and \texttt{\end{subequations}} formulas can be subnumbered. Both commands are inserted in \TeX{} mode.

An example:

\begin{align*}
A &= C - B & \text{(19)} \\
B &= C - A & \text{(20a)} \\
C &= A + B & \text{(20b)}
\end{align*}

To create the example, the following is done:

1. first formula is inserted
2. \texttt{\begin{subequations}} is inserted after the first formula
3. second formula is inserted
4. third formula is inserted
5. \texttt{\end{subequations}} is inserted after the third formula

Every formula between the commands \texttt{\begin{subequations}} and \texttt{\end{subequations}} will be subnumbered with a, b, c, \ldots{} in the output. For multiline formulas every line will be subnumbered.

Referencing subequations work like for normal equations: (20a), (20b). If you want to reference the subequations collectively, insert a label directly after \texttt{\begin{subequations}} and reference it. Formula (21) is an example.

By inserting commands in \TeX{} mode, a space is created between the first two formulas. To revert this -5 mm vertical space is inserted after the command \texttt{\begin{subequations}}. When the formula style Indented\textsuperscript{42} is used, -7 mm space is inserted instead.

To get another subnumber instead of small Latin letters, insert this command as TeX code after \texttt{\begin{subequations}}:

\begin{verbatim}
\renewcommand{\theequation}{\theparentequation-\roman{equation}}
\end{verbatim}

\textsuperscript{41} \texttt{tag} is described in sec. 19.4.

\textsuperscript{42} formula styles see sec. 17
\texttt{theparentequation} creates hereby the parent number and \texttt{roman\{equation\}} adds a small Roman number as subnumber. For more information about the customization of the numbering, see sec. 19.5.

Here is an example for a multiline formula where the numbering is customized and turned off for the second line:

\[
\]

(21-i) (21-ii)

\textbf{19.4. User-defined Numbering}

With the standard numbering parentheses are set around the formula number. To replace the parentheses for example by vertical bars, the following line is added to the \LaTeX-preamble:

\[
\texttt{def\{tagform@\#1\{\maketag@@@{|\#1|}\}}
\]

To use other characters, the vertical bars besides the \#1 are replaced by one or more characters. To get only the formula number the vertical bars are omitted.

When there should be an expression of your choice instead of the consecutive formula number in parentheses behind the formula, the command \texttt{tag} is used:

\[
A + B = C \quad (\text{something})
\]

In this example the command \texttt{tag\_something} was inserted in the formula.

When the command \texttt{tag\_something} is inserted instead, the star prevents the parentheses around the expression:

\[
A + B = C \quad \text{something}
\]

To restart the formula numbering with new document parts or sections, the following command is used:

\[
\texttt{@addtoreset\{equation\}\{part\}}
\]

resp.

\[
\texttt{@addtoreset\{equation\}\{section\}}
\]

To be able to use these commands in \TeX mode, the “@” character has to be made “active” for \TeX using the command \texttt{makeatletter}. The command \texttt{makeatother} reverts this. So the command sequence in \TeX mode is:

\[
\texttt{makeatletter}
\]

\[
\texttt{@addtoreset\{equation\}\{section\}}
\]

\texttt{makeatother}

54
In the \LaTeX-preamble \texttt{\makeatletter} and \texttt{\makeatother} can be omitted as they are automatically internally inserted by \LaTeXX.

To revert \texttt{\@addtoreset}, the file \texttt{remreset.sty}\footnote{\texttt{remreset} is part of the \LaTeXX-package \texttt{carlisle} that is part of every \LaTeXX standard installation.} has to be loaded in the \LaTeX-preamble with the line
\begin{verbatim}
\usepackage{remreset}
\end{verbatim}
Then the command \texttt{\@removefromreset} can be used with the same scheme as \texttt{\@addtoreset}.

Sometimes formulas should be numbered in the following form:
\begin{verbatim}
(section number.formula number)
\end{verbatim}
The formula number should start with every section with “1”.

For this case there is the command \texttt{\numberwithin}, which is used with the following scheme:
\begin{verbatim}
\numberwithin{counter}{sectioning}
\end{verbatim}
Counter denotes what kind of numbering is affected, sectioning denotes what number is before the dot.

Thus in our case the following \LaTeX preamble or \TeX code line is used:
\begin{verbatim}
\numberwithin{equation}{section}
\end{verbatim}
This is the result:
\begin{equation}
A + B = C \tag{19.22}
\end{equation}

To number e.g. tables so that the number of the part is the sectioning, \texttt{\numberwithin{table}{part}} is used.

To go back to the standard numbering or to prevent this kind of numbering when it is defined by the document class, the following command is inserted as \TeX code or to the \LaTeX preamble:
\begin{verbatim}
\renewcommand{\theequation}{\arabic{equation}}
\end{verbatim}
or
\begin{verbatim}
\renewcommand{\thetable}{\arabic{table}}
\end{verbatim}
\texttt{\numberwithin} uses internally the command \texttt{\@addtoreset}, described above, that also needs to be reverted.
19.5. Numbering with Roman Numbers and Letters

Formulas can also be numbered with Roman numbers and Latin letters. To number for example with small Roman numbers, the command
\renewcommand{\theequation}{\roman{equation}}

is inserted before the formula in \TeX\ mode. \renewcommand redefines the predefined command \theequation to the command \roman{equation}. \roman{equation} is the formula counter. When the command \the is used as prefix for a counter, the value of the counter is output as Arabic number. When a formula is numbered, \TeX\ sets internally the command \theequation behind the formula. \roman{equation} outputs the counter as small Roman number.

All formulas behind the command \renewcommand are now numbered Roman. To switch to numbering with big Roman numbers, the command is inserted again, but \roman is replaced by \Roman. To “number” with small Latin letters there is the command \alph, for big ones there is the command \Alph.

Note: Only maximal 26 formulas can be numbered with Latin letters in one document.

\begin{align*}
A &= \text{small roman} & (\text{xxiii}) \\
B &= \text{big Roman} & (\text{XXIV}) \\
C &= \text{small Latin} & (y) \\
D &= \text{big Latin} & (Z)
\end{align*}

To switch back to the default numbering, insert the command:
\renewcommand{\theequation}{\arabic{equation}}

\begin{align*}
E &= \text{Arabic} & (27)
\end{align*}

As you see, formulas are numbered serially independent from the numbering style. When then numbering should start with “1” when the style is changed, new equation counters have to be defined. A description about this can be found in the file Formula-numbering.lyx.

44The command \renewcommand has the same scheme like the command \newcommand that is described in sec. 22.1.
20. Chemical Symbols and Equations

An example text from chemistry:

The $\text{SO}_4^{2-}$-ion reacts with two $\text{Na}^+$-ions to sodium sulfate ($\text{Na}_2\text{SO}_4$). The chemical equation for this is:

$$2 \text{Na}^+ + \text{SO}_4^{2-} \rightarrow \text{Na}_2\text{SO}_4$$

This chemical equation can directly be created as formula. To avoid that the symbols appear italic, everything is highlighted and changed by the shortcut Alt+C R to the upright font style.45

A more convenient way to typeset chemical formulas is to use the command \ce that is available when the \LaTeX-package \texttt{mhchem} is installed. After inserting \ce to a formula a new blue box appears where chemical formulas can be inserted in an intuitive way.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\ce{H2CO3}</td>
<td>$\ce{H2CO3}$</td>
</tr>
<tr>
<td>\ce{SO4^2-}</td>
<td>$\ce{SO4^{2-}}$</td>
</tr>
<tr>
<td>\ce{(NH4)2S}</td>
<td>$(\text{NH}_4)_2\text{S}$</td>
</tr>
<tr>
<td>\ce{KCr(SO4)2.12H2O}</td>
<td>$\text{KCr(SO}_4\text{)}_2 \cdot 12 \text{H}_2\text{O}$</td>
</tr>
<tr>
<td>\ce{A-B\dbond/\text{C}\tbond/\text{D}}</td>
<td>A–B=C≡D</td>
</tr>
<tr>
<td>\ce{227\downarrow_{90}\rightarrow\text{Th}^+}</td>
<td>$^{227}_{90}\text{Th}^+$</td>
</tr>
<tr>
<td>\ce{\mu-hyphen/Cl}</td>
<td>$\mu$-Cl</td>
</tr>
<tr>
<td>\ce{CO2+]<em>\text{&lt;=}C\text{&lt;=}</em>{\geq}2CO}</td>
<td>$\text{CO}_2 + \text{C} \iff 2\text{CO}$</td>
</tr>
<tr>
<td>\ce{CO2+]<em>\text{&gt;=}C\text{&gt;=}^{[\alpha][\beta]}</em>{2\text{CO}}</td>
<td>$\text{CO}_2 + \text{C} \xrightarrow[\beta]{\alpha} 2\text{CO}$</td>
</tr>
</tbody>
</table>

Note: It is not possible in LyX to use the character ^ to get an up-arrow as described in the \texttt{mhchem} manual. One instead uses a negative thin space followed by the command \texttt{\uparrow}:

$$\text{Fe} + 2 \text{H}^+ \rightarrow \text{Fe}^{2+} + \text{H}_2\uparrow$$

Using \ce the command for equation (28) is:

\ce{2Na^+ + \text{SO}_4^{2-} \rightarrow \text{Na}_2\text{SO}_4}

To create multiline chemical equations first a multiline formula is created as described in sec. 18. Afterwards the command \ce is used in every small blue box of the formula.

\textsuperscript{45}font styles see sec. 11.1
(29) and (30) are an example of a multi-stage chemical reaction where every equation has its own number.

\[
\begin{align*}
\text{TEOS} + 4 \text{O} & \longrightarrow \text{Si(OH)}_4 + 4 \text{C}_2\text{H}_4\text{O} \quad \text{(29)} \\
\text{Si(OH)}_4 & \longrightarrow \text{SiO}_2 + 2 \text{H}_2\text{O} \quad \text{(30)}
\end{align*}
\]

Besides \texttt{ce} the \texttt{mhchem} package provides the command \texttt{cf} that has to be used for special cases. For more information about \texttt{cf} and more examples have a look at the documentation of \texttt{mhchem}, [7].

21. Diagrams

\LaTeX{} supports two types of commutative diagrams: \texttt{amscd} and \texttt{xymatrix} that are explained in the following.

21.1. Amscd Diagrams

Diagrams of this type visualize relations by vertical and horizontal lines or arrows:

\[
\begin{array}{c}
A \quad \longrightarrow \quad B \quad \longrightarrow \quad C \\
\quad \quad \uparrow \quad \quad \quad \downarrow \\
F \quad \quad \longleftarrow \quad E \quad \longleftarrow \quad D
\end{array}
\]

To get them, the command \texttt{CD} is inserted to a formula. A blue box appears with two dashed lines where further commands can be inserted. With Ctrl+Return a new line is created. Horizontal relations are inserted in odd, vertical in even formula lines.

To create the relations there are the following commands:

- \texttt{@<<<} creates a left arrow, \texttt{@>>>} a right arrow and \texttt{@=} a long equal sign
- \texttt{@AAAA} creates an up arrow, \texttt{@VVV} a down arrow and \texttt{@|} a vertical equal sign
- \texttt{@.} is a placeholder for non-existent relations

All arrows can be labeled as follows:

- If text inserted between the first and second < or >, resp., it is placed above the arrow. When it is inserted between the second and third one, it appears under the arrow.
- When text for vertical arrows is inserted between the first and second A or V, resp., it is placed left beside the arrow. When it is inserted between the second and third one, it appears right beside the arrow. If the text contains an A or V, these letters must be set into a \TeX{} brace.

58
As example a diagram with all possible relations:

\[
\begin{align*}
A & \xrightarrow{j} B \xrightarrow{k} C \quad F \\
D & \xleftarrow{j} E \xrightarrow{k} F \quad C
\end{align*}
\]

The command for this is:
\[
\text{CD_A@>j>B@>k>C=F Ctrl+Return} \\
\text{AmAA@.VV\{V\rightarrow V\}@ Ctrl+Return} \\
\text{D@<j<E@>k>F=C}
\]

21.2. Xymatrix Diagrams

To be able to use xymatrices, the \LaTeX-package \texttt{xypic} must be installed. A xymatrix is created by inserting the command \texttt{xymatrix} in a formula. Then you are able to add new matrix columns and rows like for normal matrices, see sec. 4.

In contrary to amscd diagrams, xymatrices supports diagonal and curved arrows, and much more. All possibilities to create commutative diagrams and decorations are explained in detail in the \textit{XY-pic manual} that you find in the menu Help$\rightarrow$Specific Manuals.

21.3. Feynman Diagrams

To be able to use \texttt{Feynman}-diagrams, the \LaTeX-package \texttt{feyn} must be installed. A \texttt{Feynman}-diagram is created by inserting the command \texttt{Diagram} in a formula. Then you are able to add new matrix columns and rows like for normal matrices, see sec. 4.

Examples how to create \texttt{Feynman}-diagrams in LyX is given in the \textit{Feynman-diagram manual} that you find in the menu Help$\rightarrow$Specific Manuals.
22. User-defined Commands

**Note:** The names of user-defined commands and macros may only consist of Latin letters.

22.1. The Command \texttt{\newcommand}

Many \LaTeX-commands are too long to be used frequently. But it is possible to define with the command \texttt{\newcommand} new shorter commands.

The command scheme of \texttt{\newcommand} is:

\begin{verbatim}
\newcommand{newcommandname}[numberofarguments][optionalvalue]{command definition}
\end{verbatim}

**Note:** Assure that the name of the new command is not already used in your document or by \LaTeX-packages that you use. When you for example define the command \texttt{\le} for \texttt{\Leftarrow}, you get an error message because \texttt{\le} is already defined as command for “≤”.

The number of arguments is an integer in the range 0-9 and specifies how many arguments the new command should have. With the optional value a value for an optional argument can be predefined. When this is done, the first argument of the new command is automatically an optional one.

Here are some examples:

- To define the command \texttt{\gr} for \texttt{\Longrightarrow}, the \LaTeX-preamble line is:
  \begin{verbatim}
  \newcommand{\gr}{\Longrightarrow}
  \end{verbatim}

- To define the command \texttt{\us} for \texttt{\underline}, the argument (that should be underlined) must be taken into account. For this the preamble line is:
  \begin{verbatim}
  \newcommand{\us}[1]{\underline{#1}}
  \end{verbatim}

  The character \texttt{#} acts as argument placeholder, the \texttt{1} behind it denotes that it is the placeholder for the first argument.

- For \texttt{\framebox} one can e.g. define the command \texttt{\fb}:
  \begin{verbatim}
  \newcommand{\fb}[3]{\framebox#1#2{$#3$}}
  \end{verbatim}

  The two Dollar signs creates the extra formula needed for \texttt{\framebox}, see sec. 9.1.

- To create a new command for \texttt{\fcolorbox} where the color for the box need not be specified, the argument for the color is defined optional:
  \begin{verbatim}
  \newcommand{\cb}[3][white]{\fcolorbox{#2}{#1}{$#3$}}
  \end{verbatim}

  When the color is not specified when using \texttt{\cb}, the predefined color \texttt{white} will be used.
A test of the new defined commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>A\gr.B</td>
<td>A \rightarrow B</td>
</tr>
<tr>
<td>\us{ABcd}</td>
<td>ABcd</td>
</tr>
<tr>
<td>\fb{2cm}\rightarrow{\int_A=B</td>
<td>\int A = B</td>
</tr>
<tr>
<td>\cb{red}\rightarrow{\int_A=B</td>
<td>\int A = B</td>
</tr>
<tr>
<td>\cb[green]{red}\rightarrow{\int_A=B</td>
<td>\int A = B</td>
</tr>
</tbody>
</table>

22.2. Math Macros

User-defined commands are especially convenient for complex expressions. When you are for example dealing with a document that has quadratic equations, the same solution type occurs several times. The general form of a quadratic equation is

$$0 = \lambda^2 + p\lambda + q$$

The general form of the solution is

$$\lambda_{1,2} = -\frac{p}{2} \pm \sqrt{\frac{p^2}{4} - q}$$

To define a command for the solution formula where only the three parameters $\lambda$, $p$ and $q$ need to be specified and the index of $\lambda$ can be given optionally, the \LaTeX-preamble line is

\newcommand{\qG}[4][1,2]{#2_{#1}=-\frac{#3}{2}\pm\sqrt{\frac{#3^{2}}{4}-#4}}

To create with this the solution formula, the command \qG{\lambda\rightarrow\{p\rightarrow\{q is inserted to a formula.

The definition of the new command is unintuitive because one has to know the schemes of all used \LaTeX commands, e.g. that a fraction is inserted in \LaTeX as \frac{numerator}{denominator}. Furthermore one can easily forget a brace in the definition and cannot see in LYX what the new command is doing. To avoid these problems LYX offers the possibility to use math macros instead of the command \newcommand.

A math macro is created by using the menu Insert > Math > Macro or the toolbar button \math. The math macro toolbar appears together with the following box where the macro is defined:
\newmacroname is the default name of the macro that should be changed to something sensible. The wanted formula is inserted in the first blue box. An argument placeholder is inserted with the command \#argumentnumber, e.g \#1 or by using the macro toolbar button \textcopyright. Argument placeholders are displayed red. A maximum of 9 arguments are possible. Optional arguments are created with the toolbar button \textcopyright. The first non-optional argument can be transformed to an optional one with the toolbar button \textcopyright. In the second blue box the appearance of the macro in LyX can be defined. Normally you want to see it as it is defined, so the box is kept empty. But when you have created a macro that needs lot of space on the screen, you can insert in the box for example \textcopyright: \#1, \#2, \#3, \#4

For the macro only the arguments with the macro name in front of them will then be displayed in LyX, leading to a better overview. The formula appears in the output as defined in the first box.

The appearance of macros in formulas can furthermore be changed for single macros by setting the cursor in the macro and using the menu View\textcopyright(Un)fold Math Macro.

To use a macro, the macro name is inserted as command to a formula, in our case \textcopyright. Our macro looks in LyX like this:

Here is our macro example with the arguments \(x\), \(\ln(x)\) and \(B\):

\[ x_{1,2} = -\frac{\ln(x)}{2} \pm \sqrt{\frac{\ln(x)^2}{4} - B} \]

LyX offers in the menu Tools\textcopyrightPreferences\textcopyrightEditing\textcopyrightControl different styles to edit macros. To find the style that suits you the most, choose a style and set the cursor in a macro formula to see the difference.

A math macro is transformed internally to a \textcopyrightnewcommand command when exporting the document. The created \textcopyrightnewcommand command is not placed in the \textcopyrightLATEX-preamble, therefore macros can only be used in formulas that are in the document below the macro definition box.

Math macros can also be directly created from a \textcopyrightnewcommand command. When writing for example the command

\textcopyrightnewcommand{\larrow}[2]\{\xleftarrow[#2]{#1}\}

in LyX as normal text, highlighting it completely and using then the shortcut Ctrl+M, the command will be transformed to a math macro. Using this method you need to be careful that the \textcopyrightnewcommand command is typed correctly, otherwise you get a faulty macro leading to \textcopyrightLATEX errors.

Math macros currently have the problem that further formulas in macro definitions are handled wrongly. Therefore the example \textcopyrightfb from sec. 22.1 cannot be created as macro.

62
When the cursor is in a macro definition box, you will see the macro toolbar in LYX:

The macro toolbar contains from left to right the following buttons:

- **Edit**
- **Math**
- **Macro Definition**
- **Remove Last Argument**
- **Append Argument**
- **Transform First Non-Optional to Optional Argument**
- **Transform Last Optional to Non-Optional Argument**
- **Remove Optional Argument**
- **Insert Optional Argument**
- **Remove Last Argument**
- **Eating From The Right**
- **Append Argument**
- **Eating From The Right**
- **Append Optional Argument**
- **Eating From The Right**

## 23. Computer Algebra Systems

LYX offers the exchange between mathematical expressions written in LYX’s math editor and external applications or user defined scripts. Currently supported applications are *Maple, Mathematica, Maxima* and *Octave*. Note that the set of supported mathematical constructs is limited only to very simple cases.

### 23.1. Usage

Write some expression in a formula, go to the **Edit > Math > Use Computer Algebra System** menu and choose the application you have installed on the computer. After that the result of computation should show on the right side of the expression together with the “=” operator.

Here are few simple examples (with results from *Maxima*) to show what kind of computations can be performed:
\cdot \frac{37}{3} \cdot 2 - \sum_{i=1}^{3} i^i = -\frac{22}{3}
\cdot \frac{37.0}{3} = 12.33333333333333
\cdot \int_{1}^{2} \sin(x) dx = \cos 1 - \cos 2
\cdot \int \left( \frac{1}{1+x^3} \right) dx = -\frac{\log(x^2-x+1)}{6} + \frac{\arctan \left( \frac{2x+1}{\sqrt{3}} \right)}{\sqrt{3}} + \frac{\log(x+1)}{3}
\textbf{Note:} One needs to use proper delimiter insets ( ) instead of simple '()' characters.
\cdot \det \begin{bmatrix} 1 & 6 & 7 \\ 2 & 5 & 8 \\ 3 & 4 & 17 \end{bmatrix} = -56
\cdot \lim_{x \to 0} \left( \frac{\sin(x)}{x} \right) = 1
\cdot \text{powerseries} \left( -\log (5-x), x, 1 \right) = \sum_{i_2=0}^{\infty} \frac{4^{-i_2-1} (x-1)^{i_2+1}}{i_2+1} - \log 4
\cdot \text{solve} \left( x_1 + y_1^3 = y_1 + x_1^2, x_1 \right) = \left\{ \begin{array}{l} x_1 = -\frac{\sqrt{4y_1^3-4y_1+1} + 1}{2}, \\
y_1 = \frac{\sqrt{4y_1^3-4y_1+1}}{2} \end{array} \right\}

### 23.2. Keyboard shortcut

Currently there is no keyboard shortcut for calling the algebra applications. One can easily bind a shortcut to the \texttt{math-extern} \LaTeX function (see the \texttt{LyX Functions} manual). One could e.g. bind the \texttt{Return} key inside the math editor. To bind it to \texttt{Maxima} one would use this shortcut definition command:

\texttt{command-alternatives paragraph-break;math-extern maxima}

### 24. Miscellaneous

#### 24.1. Negative Numbers

Negative numbers often look ugly in formulas because the minus sign before the number is set with the same length as the minus operator sign. When writing the negative number in normal text, the minus sign appears correctly.

Thus, the problem disappears when converting the minus sign to mathematical text.

An example to visualize the problem:

| normal text: x = -2 |
| formula: x = -2   |
| solution: x = -2  |
24.2. Comma as decimal Separator

In \LaTeX a comma inside a formula is used, according to the English convention, as number group separator. So there will be space added behind all commas in formulas. To avoid this, the comma is highlighted and changed to mathematical text (shortcut Ctrl+M).

To use all formula commas in the document as decimal separator, the file \texttt{icomma.sty} is loaded with the \LaTeX-preamble line

\texttt{\usepackage{icomma}}

24.3. Physical Vectors

Predefined vectors are offered by the \LaTeX-package \texttt{braket} that is loaded with the \LaTeX-preamble line

\texttt{\usepackage{braket}}

The following commands are defined:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\Bra{\psi}</td>
<td>\langle \psi \rangle</td>
</tr>
<tr>
<td>\Ket{\psi}</td>
<td>\vert \psi \rangle</td>
</tr>
<tr>
<td>\Braket{\psi</td>
<td>\phi}</td>
</tr>
</tbody>
</table>

The command \texttt{\Braket} assures that all vertical bars are set in the size of the surrounding brackets:

$\left\langle \phi \left| J = \frac{3}{2}, M_J \right. \right\rangle$

The effect of \texttt{\Braket} can also be achieved using the command \texttt{\middle}, that is described in sec. 5.1.2.

24.4. Self-defined Fractions

To define custom commands for fractions, the command \texttt{\genfrac} is used in the following scheme:

\texttt{\genfrac{left bracket}{right bracket}{fraction bar thickness}{style} numerator denominator}

The style is a number in the range of 0 - 3.

\texttt{icomma} is part of the \LaTeX-package was.
When no style is given, the size is adjusted to the surrounding environment like for the command \texttt{\frac}.

When no fraction bar thickness is given, the predefined value of 0.4 pt will be used.

For example, the commands \texttt{\dfrac} and \texttt{\tbinom} from sec. 3.2 are defined with the commands

\begin{verbatim}
\newcommand{\dfrac}[2]{\genfrac{}{}{}{0}{#1}{#2}}
\end{verbatim}

and

\begin{verbatim}
\newcommand{\tbinom}[2]{\genfrac{(}{)}{0pt}{1}{#1}{#2}}
\end{verbatim}

To define a fraction where the fraction bar thickness can be given as optional argument, the following line is inserted to the \LaTeX-preamble:

\begin{verbatim}
\newcommand{\fracS}[3][]{\genfrac{}{}{#1}{}{#2}{#3}}
\end{verbatim}

A test:

\begin{verbatim}
\fracS[1mm]{\{A→\{B\}}
\fracS[5mm]{\{A→\{B
\end{verbatim}

As one can see, the distance of the numerator and the denominator to the fraction bar is round about three times the bar thickness.
24.5. Canceled Formulas

There are four ways to cancel formulas or parts of formulas:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\cancel</code>\int A=B</td>
<td>$\int A=B$</td>
</tr>
<tr>
<td><code>\bcancel</code>\int A=B</td>
<td>$\not\int A=B$</td>
</tr>
<tr>
<td><code>\xcancel</code>\int A=B</td>
<td>$\cancel[\textcolor{red}]{\int A=B}$</td>
</tr>
<tr>
<td><code>\cancelto</code>\int A=B→1</td>
<td>$\int A=B^{1-}$</td>
</tr>
</tbody>
</table>

\cancelto is especially suitable to visualize the reduction of fractions within formulas:

$$\frac{(x_0 + bB)^2}{(1 + b^2)^{\frac{1}{2}}} = \frac{x_0^2 + B^2 - r_g^2}{1 + b^2}$$

To change the size of \cancelto’s “subscript” value one can add the \TeX-preamble line

```latex
\PassOptionsToPackage{option}{cancel}
```

where option is either \texttt{samesize} which leads to the same size as for the canceled value, or \texttt{Smaller} which makes it a bit smaller than normal.

To color the cancellation bar one adds this command as \TeX code:

```latex
\renewcommand{\CancelColor}{\color{red}}
```

red can be replaced by a color of your choice.

$$\frac{(x_0 + bB)^2}{(1 + b^2)^{\frac{1}{2}}} = \frac{x_0^2 + B^2 - r_g^2}{1 + b^2}$$

For further customizations, see the documentation of the package cancel, [5].

24.6. Formulas in Section Headings

When formulas are used in section headings, the following has to be taken into account:

When \texttt{hyperref} support is enabled in the document settings dialog under PDF Properties, PDF-bookmarks are created for every section heading in the table of contents. If a section heading contains formulas, they are incorrectly displayed in the bookmark text, because formulas in bookmarks infringe the PDF conventions.
Both problems can be solved by inserting at the end of the section heading a short title with the menu Insert > Short Title. Short titles are used as alternative for multiline section headings to keep the table of contents clearly arranged. Only the short title appears in the table of contents and therefore also in the PDF-bookmark.

When formulas should be used in the table of contents but hyperref is used, one can use the following command in \TeX mode:
\texorpdfstring{part}{alternative}

Part is the part of the heading that shouldn’t appear in the PDF-bookmark. This can be characters, formulas, footnotes, but also cross-references. The alternative is used instead of the part for the bookmark.

Here are two example headings:

**24.6.1. Heading without formula in table of contents** \(\sqrt{-1} = i\)

**24.6.2. Heading with formula in table of contents** \(\sqrt{-1} = i\)

In the first heading a short title was used, in the second one \texorpdfstring. To get the same formatting as for the other headings, the complete heading was set into a \texttt{boldmath} environment\(^{47}\).

### 24.7. Formulas in multi-column Text

Formulas in multi-column text are often too wide to fit into a column and thus need to be set over the whole page width. This is done by using the \LaTeX-package \texttt{multicol}\(^{48}\), that is loaded with the \LaTeX-preamble line
\begin{verbatim}
\usepackage{multicol}
\end{verbatim}

Note that in this case the setting Two-column document in the menu Document > Settings under Text Layout must not be selected.

Before the multi-column text the command
\begin{verbatim}
\begin{multicols}{column number}
\end{multicols}
\end{verbatim}

is written in \TeX mode. The column number is a number in the range of 2-10. Before the formula the multi-column text is ended by inserting the command
\begin{verbatim}
\end{multicols}
\end{verbatim}
in \TeX mode.

\(^{47}\)see sec.11.2

\(^{48}\)multicol is part of every \LaTeX standard installation.
Due to the command some space is automatically added before the formula. To revert this, -6mm vertical space is inserted before the formula. When the formula style \textit{Indented}\textsuperscript{49} is used, -9mm space is inserted instead.

As example a multi-column text with a displayed formula:

Das Spektrum wird fouriertransformiert. Die Fouriertransformation wird verwendet, um die überlagerten Signale (Netzwerk, Lösungsmittel) zu trennen. Nachdem wir die Phasenverschiebung bestimmen konnten, interessiert uns nun das Aussehen des Ausgangssignals. Im Experiment haben wir es mit sehr vielen Teilchen zu tun, so dass man über alle Phasen integrieren muss. Sei nun $S$ unser normiertes Ausgangssignal und $P$ die Phasenverteilungsfunktion, so ergibt sich die Beziehung

$$S(t) = S_0(t) \int_{-\infty}^{\infty} P(\phi, t)e^{i\phi}d\phi$$ (31)

wobei $S_0$ das Signal ohne Gradient ist und die Normierungsbedingung $\int_{-\infty}^{\infty} P(\phi, t)d\phi = 1$ gilt. Nun dürfen wir aber nicht den Relaxationsprozess außer Acht lassen. Direkt nach dem $\pi/2$-rf-Puls beginnt sich die Magnetisierung zu entfokussieren, wodurch sich das Signal zusätzlich abschwächt. Diese Abschwächung verläuft exponentiell in Abhängigkeit der so genannten $T_2$-Zeit.

24.8. Formulas with Description of Variables

To describe variables within a formula, like in formula (32), a $2 \times n$ matrix is used with left aligned columns for the $n$ used variables.\textsuperscript{50} To set the description in a smaller size, before the matrix e.g. the command \texttt{\footnotesize} is inserted.\textsuperscript{51}

When the formula style \textit{Indented}\textsuperscript{52} is used, a \texttt{\hfill}\textsuperscript{53} is inserted before and after the matrix to have the same separation of the matrix from the equation and the side margin.

When the formula style \textit{Centered} is used, the method described in sec. 18.2.3 is used to indent formulas. Formula (32) consists of five columns where in the first two columns contain the equation, the third the matrix and the last one an empty \LaTeX{} brace.

\begin{equation}
F_A = \rho \cdot V \cdot g
\end{equation}

\begin{itemize}
\item $\rho$ density
\item $V$ volume
\item $g$ gravitational acceleration
\end{itemize}

\textsuperscript{49}formula styles see sec. 17
\textsuperscript{50}matrices see sec. 4
\textsuperscript{51}font sizes see sec. 11.4
\textsuperscript{52}formula styles see sec. 17
\textsuperscript{53}\texttt{\hfill} only works in formulas with the style \textit{Indented}, see sec. 8.2.
24.9. Upright small Greek Letters

Most of the math fonts only provide italic small Greek letters. But for symbols of elementary particles like pions and neutrinos, upright Greek letters are needed. The file `upgreek.sty`\textsuperscript{54} that is loaded with the \LaTeX-preamble line

\begin{verbatim}
\usepackage{upgreek}
\end{verbatim}

provides them. They are created when the command for a small Greek letter is started with `up`. For example the command `\uptau` creates this: $\tau$

With these commands reactions of elementary particles can be typeset:

\begin{equation}
\pi^+ \rightarrow \mu^+ + \nu_\mu
\end{equation}

The upright letters are more bold and wider than the italic ones. They should therefore not be used for units like “\textmu m”.

24.10. Text Characters in Formulas

In some cases you might want to insert text characters directly into formulas. When for example the centered dot $\cdot$ is often used in formulas like $\nu = 5 \cdot 10^5$ Hz, one would have to insert the command `\cdot`\textsuperscript{55} all the time, because this character is defined in all encodings as text character. But the encoding can be changed by this \LaTeX-preamble line:

\begin{verbatim}
\DeclareInputtext{183}{\ifmmode\cdot\else\textperiodcentered\fi}
\end{verbatim}

The character encoding (menu \textit{Document} \textgt; \textit{Settings} \textgt; Language) specifies what character appears when a keyboard key is pressed. When the key for the character ‘$\cdot$’ is pressed, internally the command \texttt{\textperiodcentered} is used. But this command is not available in a formula so that you would get \LaTeX-errors. With the changed encoding the right command is chosen automatically, depending on if the character was inserted into a formula or not.

The encoding of several characters is saved in definition files. For example the encoding \texttt{latin9} is defined in the file \texttt{latin9.def} which is in the installation folder of \LaTeX. Encodings should only be changed via the \LaTeX-preamble and not in the definition files. Otherwise documents could not be edited by other \LaTeX users working on other computers.

Besides the centered dot, in this document the degree sign ° is defined with the following \LaTeX-preamble line so that it can be directly inserted into a formula:

\begin{verbatim}
\DeclareInputtext{176}{\ifmmode^\circ\else\textdegree\fi}
\end{verbatim}

\textit{upgreek} is part of the \LaTeX-package \textit{was}.

\textit{see sec. 10.4}
24.11. \LaTeX-comments in formulas

In text you can insert a comment that will only be visible in the \LaTeX source code of your file with the menu Insert $\rightarrow$ Note $\rightarrow$ Comment. This is not possible in a formula but you can insert \LaTeX-comments with the command

\%

This creates a box in which you can write your comment. Due to a bug in LyX\textsuperscript{56} you cannot write normal text inside the comment, even when you use mathematical text, you will see its \LaTeX-commands in the \LaTeX-output.

This a formula with a \LaTeX-comment:

\[
A = B
\]

\textsuperscript{56}LyX-bug \#9002
A. Typographic Advice

This section is a summary of the most important typographic rules, listed in ISO norms.\textsuperscript{57}

- Physical units are \emph{always set upright},\textsuperscript{58} no matter if they appear in italic text: 30 km/h
  Between the value and the unit is the smallest space, see sec. 8.1.
  This convention is automatically fulfilled when the command \texttt{\textbackslash unittwo} is used. When it is entered to a formula, two boxes appear. In the first one the value is inserted, in the second one the unit, and one gets as above: 30 km/h. Note that \texttt{\textbackslash unittwo} is not a real L\TeX\ command but the command \texttt{\textbackslash unit\{value\}\{unit\}}, therefore you cannot use it in \TeX\ code.

- Percent and perthousand signs are set like physical units: 1.2 \%‰ alcohol in blood

- The degree sign follows directly on the value: 15°, but not when it is used in units: 15 °C

- In numbers with more than four digits the smallest space is inserted before every third digit to group them: 18473588

- For dimensions like 120×90×40 cm the multiplication sign “×” is used. It is available either via the command \texttt{\textbackslash times} or via the menu \texttt{Insert\textgreater Special Character\textgreater Symbols}.

- Functions with names consisting of several letters are set upright to avoid confusions, see sec. 15.1.

- Indices consisting of several letters, are set upright: $E_{\text{kin}}$
  Components of matrices are set italic: $H_{kl}$

- The differentiation/integration operator ‘d’, the Euler’s number ‘e’ and the imaginary unit ‘i’ should be set upright, to avoid mixing them up with other variables.

- The character that denotes a \textsc{fourier} transformation is inserted either by the command \texttt{\textbackslash mathscr\{F\}} or via the menu \texttt{Insert\textgreater Special Character\textgreater Symbols\textgreater Letterlike Symbols: $\mathcal{F}$}

\textsuperscript{57}This collection was partly taken from the German semi-official dictionary called “Duden” \cite{8} that lists some of the ISO rules. More rules are listed in \cite{9}.

\textsuperscript{58}done with font styles, see sec. 11.1
### B. Synonyms

Some characters and symbols can be created with several commands. Here is a list of the synonym commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>equivalent to</th>
<th>Command</th>
<th>equivalent to</th>
</tr>
</thead>
<tbody>
<tr>
<td>\ast</td>
<td>*</td>
<td>\backslash</td>
<td>|</td>
</tr>
<tr>
<td>\choose</td>
<td>\binom</td>
<td>\dasharrow</td>
<td>\dashrightarrow</td>
</tr>
<tr>
<td>\geq</td>
<td>\ge</td>
<td>\land</td>
<td>\wedge</td>
</tr>
<tr>
<td>\lbrace</td>
<td>{</td>
<td>\rbrace</td>
<td>}</td>
</tr>
<tr>
<td>\lbracket</td>
<td>[</td>
<td>\rbracket</td>
<td>]</td>
</tr>
<tr>
<td>\leftarrow</td>
<td>\gets</td>
<td>\rightarrow</td>
<td>\to</td>
</tr>
<tr>
<td>\leq</td>
<td>\le</td>
<td>\lnot</td>
<td>\neg</td>
</tr>
<tr>
<td>\lor</td>
<td>\lor</td>
<td>\ne</td>
<td>\not=</td>
</tr>
<tr>
<td>\neq</td>
<td>\not=</td>
<td>\owns</td>
<td>\ni</td>
</tr>
<tr>
<td>\slash</td>
<td>/</td>
<td>\square</td>
<td>\Box</td>
</tr>
<tr>
<td>\vert</td>
<td>|</td>
<td>\Vert</td>
<td>|</td>
</tr>
</tbody>
</table>
References


[2] Description of \LaTeX’s math abilities

[3] Description of AMS-\LaTeX

[4] List of all symbols available with \LaTeX-packages

[5] Documentation of the \LaTeX-package *cancel*

[6] Documentation of the \LaTeX-package *hyperref*

[7] Documentation of the \LaTeX-package *mhchem*


[9] Check list for reviewing manuscripts